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I. ZAMAWIAJĄCY 
Centrum Nauki Kopernik 
00-390 Warszawa, ul. Wybrzeże Kościuszkowskie 20 
NIP: 701-002-51-69  REGON: 140603313 
 
strony www:  www.bip.kopernik.org.pl 
   www.kopernik.org.pl 

 
Postępowanie o udzielenie zamówienia publicznego prowadzone jest za pośrednictwem elektronicznej 
platformy zakupowej pod adresem:  

 
https://www.platformazakupowa.pl/transakcja/930560 

 
II. TRYB UDZIELENIA ZAMÓWIENIA ORAZ OZNACZENIE POSTĘPOWANIA 

1. Postępowanie o udzielenie zamówienia prowadzone jest w trybie zapytania ofertowego z pominięciem 
przepisów ustawy Prawo zamówień publicznych, na podstawie warunków określonych w niniejszym 
zapytaniu ofertowym. 

2. Niniejsze postępowanie oznaczone jest znakiem sprawy: DZP.261.74.2024.DP, wykonawcy zobligowani 
są do powoływania się na wyżej wskazane oznaczenie we wszelkich kontaktach z zamawiającym. 

3. Postępowanie prowadzone jest w języku polskim. 
 
III. PRZEDMIOT ZAMÓWIENIA 

1. Przedmiotem zamówienia jest wykonanie i dostawa 18 zestawów elektronicznych „CanSat Kit” 
2. Szczegółowy opis przedmiotu zamówienia stanowi załącznik nr 1 wraz z regulaminem Konkursu  

i dokumentacją zestawu. 
3. Oznaczenie CPV: 98300000-6 Różne usługi 
4. Termin wykonania przedmiotu zamówienia: nie później niż do dnia 28.10.2024. 

 
IV. WARUNKI UDZIAŁU W POSTĘPOWANIU 

1. W postępowaniu o udzielenie niniejszego zamówienia mogą się ubiegać wykonawcy, którzy spełniają 
następujący warunek udziału, tj.:  
1) nie podlegają wykluczeniu z postępowania na podstawie art. 7 ust. 1 ustawy O szczególnych 

rozwiązaniach w zakresie przeciwdziałania wspieraniu agresji na Ukrainę oraz służących ochronie 
bezpieczeństwa narodowego; 

2. Wykonawca spełnienie warunku udziału w postępowaniu, o którym mowa w pkt 1, potwierdza  
w złożonej ofercie (formularzu). 

 
V. INFORMACJA O SPOSOBIE POROZUMIEWANIA SIĘ ZAMAWIAJĄCEGO Z WYKONAWCAMI 

1. Komunikacja między zamawiającym a wykonawcą w niniejszym postępowaniu odbywa się pod rygorem 
nieważności przy użyciu środków komunikacji elektronicznej za pośrednictwem platformy zakupowej – 
dostępnej pod adresem www: 

www.platformazakupowa.pl/pn/kopernik 
 

2. Wykonawca, w niniejszym postępowaniu może złożyć ofertę wyłącznie za pośrednictwem platformy, 
o której mowa w pkt. 1. Złożenie oferty możliwe jest po zalogowaniu się Wykonawcy (zarejestrowaniu) lub 
bez logowania. 

http://www.bip.kopernik.org.pl/
https://www.platformazakupowa.pl/transakcja/930560
http://www.platformazakupowa.pl/pn/kopernik
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3. Składanie przez wykonawcę oświadczeń i dokumentów, innych niż w pkt. 2, odbywa się elektronicznie za 
pośrednictwem platformy zakupowej, za pośrednictwem formularza „wyślij wiadomość do zamawiającego” 
dostępnego na stronie niniejszego postępowania. 

4. Wykonawca może się zwrócić do zamawiającego z wnioskiem o wyjaśnienie treść dokumentów 
zamówienia. Wniosek wykonawca składa za pośrednictwem platformy zakupowej – formularza „wyślij 
wiadomość do zamawiającego” dostępnego na stronie niniejszego postępowania. 

5. Wniosek, o którym mowa w pkt. 2 można składać w terminie do dnia 29 maja 2024 roku do godziny 09:00. 
6. Zamawiający wyjaśnienia treści dokumentów zamówienia, tj. treść zapytań wraz z wyjaśnieniami, bez 

ujawniania źródła zapytania, udostępni niezwłocznie, nie później niż na 2 dni przed upływem terminu 
składania ofert na stronie internetowej prowadzonego postępowania w sekcji „Komunikaty”, pod 
warunkiem że wniosek o wyjaśnienie treści zapytania ofertowego wpłynął do zamawiającego w terminie, 
o którym mowa w pkt. 5.  
W przypadku gdy wniosek o wyjaśnienie treści dokumentów zamówienia nie wpłynął w terminie, o którym 
mowa wyżej, zamawiający nie ma obowiązku udzielania wyjaśnień oraz obowiązku przedłużania terminu 
składania ofert.  
Przedłużenie terminu składania ofert nie wpływa na bieg terminu składania wniosku o wyjaśnienie treści 
dokumentów zamówienia.  

7. Za datę przekazania (wpływu) oświadczeń, wniosków, zawiadomień oraz informacji przyjmuje się datę ich 
przesłania za pośrednictwem platformy zakupowej, o której mowa w pkt 1, poprzez kliknięcie przycisku 
„Wyślij wiadomość do zamawiającego”, po których pojawi się komunikat, że wiadomość została wysłana 
do zamawiającego.  

8. Zamawiający będzie przekazywał wykonawcom informacje za pośrednictwem platformy zakupowej. 
Informacje dotyczące odpowiedzi na pytania, zmiany treści dokumentacji zamówienia, zmiany terminu 
składania i otwarcia ofert zamawiający będzie zamieszczał na platformie w sekcji „Komunikaty”. 
Korespondencja, której adresatem jest konkretny wykonawca, będzie przekazywana za pośrednictwem 
platformy do konkretnego wykonawcy.  
Wykonawca jako podmiot profesjonalny ma obowiązek sprawdzania komunikatów i wiadomości 
przesłanych przez zamawiającego bezpośrednio na platformie zakupowej. 

9. Zamawiający informuje, iż w przypadku jakichkolwiek wątpliwości związanych z zasadami korzystania 
z platformy zakupowej, Wykonawca winien skontaktować się z dostawcą rozwiązania 
teleinformatycznego, tel. +48 22 101 02 02 (infolinia dostępna od poniedziałku do piątku, w godzinach 
8:00 – 17:00).  
Dodatkowe informacje – instrukcje dotyczące korzystania z platformy zakupowej, w tym dotyczące 
w szczególności logowania, składania wniosków o wyjaśnienie treści specyfikacji, składania ofert oraz 
innych czynności podejmowanych przez wykonawcę przy użyciu platformy zakupowej dostępne są na 
stronie internetowej dostawcy rozwiązania teleinformacyjnego – adres:   

https://platformazakupowa.pl/strona/45-instrukcje  
 

10. Zamawiający do kontaktowania się z wykonawcami w sprawach dotyczących niniejszego zapytania 
ofertowego upoważnia: 
 

Daria Piątkowska - specjalistka ds. zakupów 
Dział Zamówień Publicznych 

 
 
  

https://platformazakupowa.pl/strona/45-instrukcje
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VI. TERMIN SKŁADANIA I OTWARCIA OFERT 
1. Ofertę sporządzoną w formie określonej w niniejszym rozdziale, należy złożyć za pośrednictwem platformy 

zakupowej w terminie do dnia 6 czerwca 2024 rok do godziny 09:00. 
2. Wykonawca ubiegający się o udzielenie zamówienia może złożyć tylko jedną ofertę. 
3. Treść oferty musi odpowiadać treści zapytania ofertowego. 
4. Zamawiający nie dopuszcza składania ofert wariantowych. 
5. Zamawiający nie dopuszcza składania ofert częściowych. 
6. Ofertę – wypełniony na stronie prowadzonego postępowania formularz, wykonawca składa za 

pośrednictwem platformy zakupowej. 
Wykonawca zobowiązany jest do poprawnego uzupełnienia danych wykonawcy, w szczególności należy 
zwrócić uwagę na adres e-mali, ponieważ to na wskazany adres poczty elektronicznej wykonawca 
otrzyma potwierdzenie złożenia oferty lub prośbę o potwierdzenie adresu e-mail (zależnie od tego czy 
wykonawca jest zalogowany lub czy nie posiada konta/nie jest zalogowany).  
Po zweryfikowaniu wszystkich informacji dotyczących oferty należy kliknąć przycisk „Złóż ofertę”.  
 
Instrukcje dotyczące składania, zmiany lub wycofania ofert dostępne są na stronie internetowej dostawcy 
platformy zakupowej:  

https://platformazakupowa.pl/strona/45-instrukcje 
 

7. Cenę za realizację przedmiotu zamówienia zamieszcza się w formularzu systemowym na platformie 
zakupowej z podaniem ceny ofertowej netto oraz obowiązującej stawki VAT. 

8. Przy kalkulacji ceny oferty powinny zostać uwzględnione wszystkie należności publiczno-prawne, kwotę 
podatku VAT obliczoną według stawki zgodnej z przepisami obowiązującymi na dzień składania Ofert, 
zobowiązania, koszty, narzuty i składniki, które poniesie wykonawca w związku z realizacją zamówienia,  
a także wszelkie ewentualne upusty, rabaty. 

9. Cena oferty musi być wyrażona w złotych polskich z dokładnością do dwóch miejsc po przecinku. 
10. Wykonawca do oferty powinien załączyć: 

1) Kosztorys – o którym mowa w rozdz. VII pkt. 1 ppkt. 2 
2) Harmonogram prac – o którym mowa w rozdz. VII pkt. 1 ppkt. 3 

11. Wykonawca jest związany ofertą 30 dni od dnia upływu terminu składania ofert. 
 
 
 
VII. KRYTERIA OCENY OFERT 

1. Przy dokonywaniu wyboru najkorzystniejszej oferty zamawiający stosować będzie następujące kryteria: 
1) „Cena” – 60,00 pkt – będzie rozpatrywana na podstawie ceny brutto za wykonanie przedmiotu 

zamówienia, podanej przez wykonawcę w formularzu. 
Oferty będą badane według poniższego wzoru: 
 

Liczba punktów zdobytych w kryterium „Cena” = 
najniższa cena brutto z ocenianych ofert 

x 60,00 pkt 
cena brutto badanej oferty 

 
  

https://platformazakupowa.pl/strona/45-instrukcje


DZP.261.74.2024.DP 
 

- 5 - 
 

2) „Kosztorys” – 20,00 pkt. – będzie rozpatrywany na podstawie złożonego opisu zawierającego 
kosztorys prac.  

Dopuszczalne formaty plików: PDF 

Opisany kosztorys zamawiający oceni następująco: 
• max. 20 pkt. - wyżej zostanie oceniony kosztorys opisany szczegółowo  

i z uzasadnieniem przedstawionych pozycji w kosztorysie, 
zawierający krótki opis proponowanych rozwiązań, i zastosowanych 
elementów zestawu 

3) „Harmonogram prac” – 20,00 pkt. – będzie rozpatrywany na podstawie złożonego opisu 
harmonogramu prac.  

Dopuszczalne formaty plików: PDF 

Opisany harmonogram prac zamawiający oceni następująco: 
• max. 20 pkt. - wyżej zostanie oceniony harmonogram opisany szczegółowo  

i z uzasadnieniem przedstawionych propozycji 

2. W ocenie wezmą udział pracownicy biura ESERO, którzy ocenią samodzielnie i indywidualnie nadesłane 
propozycje, i przyznają odpowiednią liczbę punktów cząstkowych za każdy z wymienionych elementów  
w niniejszym rozdziale w pkt. 1 ppkt. 2 i 3. Ostateczna liczba punktów będzie średnią arytmetyczną z sumy 
punktów cząstkowych. 

3. Każdy kosztorys i harmonogram prac będzie oceniany indywidualnie. 
4. Zamawiający uzna za najkorzystniejszą ofertę wykonawcy, który spełni wszystkie postanowienia  

w niniejszej dokumentacji oraz którego oferta uzyska największą liczbę punktów spośród złożonych ofert, 
według określonych kryteriów oceny ofert. 

5. Wszelkie obliczenia będą dokonywane z dokładnością do dwóch miejsc po przecinku. 

VIII. UDZIELENIE ZAMÓWIENIA 
1. Zamawiający, wykonawcy którego oferta zostanie wybrana, udzieli zamówienia na warunkach określonych  

w dokumentach niniejszego postępowania. 
2. Wykonawca, o którym mowa w pkt. 1, zobowiązany będzie do złożenia przed udzieleniem zamówienia 

oświadczenia o niepodleganiu wykluczeniu, o którym mowa w rozdziale IV pkt. 1 ppkt. 1 (nie dotyczy 
udzielenia zamówienia na podstawie umowy). 
 

IX. ZAŁĄCZNIKI 
Integralną częścią zapytania ofertowego są następujące dokumenty: 
a) załącznik nr 1 szczegółowy opis przedmiotu zamówienia wraz z regulaminem Konkursu 

i dokumentacją zestawu. 
b) załącznik nr 2 klauzula informacyjna z art. 13 Rozporządzenia Parlamentu Europejskiego i Rady  

    (RODO). 
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DZP.261.74.2024.DP załącznik nr 1 do zapytania ofertowego 

 

SZCZEGÓŁOWY OPIS PRZEDMIOTU ZAMÓWIENIA 

I. PRZEDMIOT ZAMÓWIENIA (INFORMACJE OGÓLNE) 
Przedmiotem zamówienia jest:  
1. Wykonanie i dostarczenie 18 zestawów elektronicznych „CanSat Kit” 
2. W ramach realizacji Konkursu CanSat 2025 w Polsce (edycja 2024-2025). 

II. PARAMETRY TECHNICZNE ORAZ FUNKCJONALNE PRZEDMIOTU ZAMÓWIENIA 
Każdy zestaw ma zawierać dwie płytki drukowane o takich samych funkcjonalnościach – jedna 
przeznaczona do umieszczenia w minisatelicie CanSat, druga służąca jako stacja naziemna – 
spełniające następujące wymagania specyfikacyjne: 

1. Przestrzeń zajmowana przez płytkę nie może przekraczać 1/3 (jednej trzeciej) maksymalnej 
kubatury minisatelity Cansat, określonej jako walec o 115 mm wysokości, 66 mm średnicy; 

2. Możliwość podpięcia karty SD; 
3. Obecność modułu radiowego, z możliwością dodania anteny zewnętrznej; 
4. Mikrokontroler kompatybilny z Arduino, czyli możliwy do zaprogramowania w środowisku 

Arduino IDE przez port USB; 
5. Dostępne złącza do podłączenia dodatkowych czujników; 
6. Możliwość zasilania bateriami litowo-jonowymi; 
7. Układ zasilający zapewniający napięcia 3,3V oraz 5V, z wydajnością większą niż 0,5A; 
8. Zapewniona dwustronna komunikacja radiowa w nielicencjonowanym paśmie amatorskim, 

posiadająca więcej niż 10 kanałów, z mocą nadajnika ponad 17 dBm; 
9. Zewnętrzne czujniki temperatury i ciśnienia, możliwe do podłączenia do komputera 

pokładowego, bez konieczności lutowania; 
10. Wszystkie komponenty muszą zawierać się na jednej, integralnej, płytce drukowanej,  

z wyłączeniem czujników temperatury i ciśnienia, które będąc czujnikami zewnętrznymi, muszą 
jednak być możliwe w podłączeniu do płytki bez konieczności lutowania. 

11. Zgodność z zapisami regulaminu Konkursu CanSat 2024 (ze zrealizowanej edycji 2023-2024),  
o którym mowa w rozdz. IV pkt. 5 – dotyczy wyłącznie wytycznych technicznych, które są 
identyczne z zapisami bieżącej edycji 2024-2025 (Konkurs CanSat 2025). 

12. Zgodność ze specyfikacją zestawów CanSat Kit, o którym mowa w rozdz. IV pkt. 5. 
 

III. TERMIN REALIZACJI 
Zestawy CanSat Kit powinny być dostarczone: 
1. do 28.10.2024 roku – dokładny termin ustalony w trybie roboczym 
2. na adres: ul. Wybrzeże Kościuszkowskie 20, 00-390 Warszawa 

IV. DODATKOWE INFORMACJE 
1. Wykonawca do oferty powinien załączyć kosztorys i harmonogram prac, o których 

mowa w rozdz. VII pkt. 1 ppkt. 2 i 3 zapytania ofertowego. 
2. Wykonawca zapewni gwarancję na wykonane zestawy i ich serwis w razie usterki –  

w terminie do 24 miesięcy od dnia podpisania protokołu odbioru. 
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3. Płatność nastąpi po wykonaniu przedmiotu zamówienia w ciągu 14 dni od dnia otrzymania 
przez zamawiającego faktury/rachunku. Podstawą do wystawienia faktury/rachunku będzie 
prawidłowe wykonanie przedmiotu zamówienia i podpisany przez obie strony protokół odbioru. 

4. Wykonawca zobowiązuje się do realizacji przedmiotu zamówienia zgodnie z warunkami 
określonymi w niniejszej dokumentacji, obowiązującymi przepisami prawa, najlepszą wiedzą, 
najlepszymi praktykami obowiązującymi na rynku oraz z należytą starannością i przy 
zastosowaniu odpowiednich umiejętności i technik. 

5. Poniżej znajdują się – kolejno: 
a) Regulamin przeprowadzonego konkursu CanSat 2024 w Polsce w 2023-2024 roku 
b) Specyfikacja – dokumentacja zestawu startowego CanSat Kit 



Konkurs CanSat wspiera firma Boeing 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 

 
 
 
 

 
 
 
 
 
 
 
 
 
 

 
 



 

2 

 

 
 
 
 
 

 
 
 
 
 

Regulamin Konkursu CanSat 2024 w Polsce 
(dalej zwany „Regulaminem”) 
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1. Postanowienia ogólne 

 

1. Regulamin określa zasady organizacji i przeprowadzenia konkursu pod nazwą „CanSat2022” 

(zwanego dalej „Konkursem”), którego organizatorem jest Centrum Nauki Kopernik z siedzibą  

w Warszawie (kod pocztowy: 00-390) przy ul. Wybrzeże Kościuszkowskie 20, wpisane do 

Rejestru Instytucji Kultury prowadzonego przez Prezydenta m.st. Warszawy pod nr 02/06 

(zwane dalej „Organizatorem”). 

 

2. Celami Konkursu są: 

- zaprojektowanie i zbudowanie minisatelity typu Cansat, o wielkości i kształcie zbliżonym do 
puszki po napoju. Szczegółowe wytyczne dotyczące Cansatów znajdują się w Rozdziale 6, 

- możliwość przejścia przez wszystkie etapy rzeczywistego projektu kosmicznego: od 

zdefiniowania celów misji, przez zaprojektowanie minisatelity CanSat, uwzględnienie 

wszystkich głównych podsystemów obecnych na satelicie, budowę prototypu, 

przeprowadzenie testów, budowę Cansata w ostatecznej formie (tzw. „lotnej”), start misji, aż 

do analizy uzyskanych podczas lotu danych; włączając w to zarządzanie projektem jego 

finansowanie i promocję misji, 

- rozwój kompetencji STEM (science, technology, engineering, mathematics) uczniów oraz ich 
umiejętności związanych z pracą projektową. 
 

3. Przedmiotem Konkursu jest wyłonienie najlepszych projektów. 

 

4. Autorzy najlepszego projektu zostaną zgłoszeni przez Organizatora do reprezentowania Polski  

w Finałach Europejskich CanSat. 

 

5. Regulamin stanowi podstawę przeprowadzenia Konkursu oraz określa prawa i obowiązki jego 

uczestników. 

 

 

2. Uczestnicy, Opiekunowie i warunki uczestnictwa 

 

1. Uczestnikami Konkursu (zwanymi dalej łącznie „Uczestnikami”, a każdy z osobna 

„Uczestnikiem”) mogą być wyłącznie uczennice/uczniowie szkoły ponadpodstawowej w wieku 

14-19 lat. Konkurs nie jest skierowany do studentów/studentek i takie zgłoszenia nie będą 

rozważane. 

 

2. Uczestnicy zgłaszani są do Konkursu w formie drużyn (zwanych dalej “Zespołami”) przez 

opiekuna/kę (zwanych dalej łącznie “Opiekunami”, a każdy/a z osobna „Opiekunem”). 
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3. Zespoły powinny spełniać następujące wymagania: 

● Zespoły powinny składać się z od 4 (czworga) do 6 (sześciorga) uczniów/uczennic,  
● Członkowie/członkinie Zespołów muszą być zarejestrowani jako uczniowie/uczennice 

odbywający naukę w szkole ponadpodstawowej w pełnym wymiarze godzin,  
● Ponad połowa członków/członkiń Zespołu musi posiadać polskie obywatelstwo, 
● Każdy Zespół musi posiadać Opiekuna/kę, 
● Członkowie/członkinie Zespołów zakwalifikowanych w poprzednich edycjach do Konkursu na 

szczeblu europejskim oraz pracownicy Organizatora nie mogą brać udziału w Konkursie. 
 

4. Opiekun odpowiada za nadzorowanie postępów prac Zespołu, służy pomocą i radą oraz jest 

pośredniczy w kontaktach między Organizatorem i Zespołem. 

 

5. Opiekun odpowiada za wszelkie działania bądź zaniechania wszystkich członków Zespołu, 

zarówno podczas etapu prac nad minisatelitami CanSat, jak i podczas spotkania finałowego.    

 

6. Rolę Opiekunów mogą pełnić wyłącznie osoby pełnoletnie, zaangażowane w proces 

edukacyjny uczestników/uczestniczek Zespołów w ramach działalności w szkole, bibliotece, 

domu kultury, etc. 

 

7. Jeden Opiekun może, podczas danej edycji Konkursu, towarzyszyć tylko jednemu Zespołowi. 
 

8. Zaleca się również, aby Zespół posiadał mentora/mentorkę z uczelni wyższej lub branży, która 
to osoba będzie mogła pomóc uczniom i uczennicom w realizacji projektu, jeżeli zakwalifikują 
się do Konkursu. 

 
9. Warunkiem wzięcia udziału w Konkursie jest przesłanie zgłoszenia w terminie i w formie 

określonej niniejszym Regulaminem (zwanego dalej „Zgłoszeniem”). Przez przesłanie 

Zgłoszenia do Konkursu rozumie się prawidłowe wypełnienie i przesłanie formularza 

zgłoszeniowego (zwanego dalej „Formularzem”) dostępnego na stronie internetowej ESERO-

Polska. Formularz należy wypełnić do dnia 21 września 2023 r., godz. 23:59. Decyduje data 

zapisania wypełnionego Formularza w systemie informatycznym Organizatora. 

 

10. Zgłoszenia dokonuje Opiekun. Opiekun może zgłosić jeden Zespół i jeden Formularz. 

 
11. O kwalifikacji do Konkursu decyduje poprawność wypełnienia Formularza i terminowość jego 

przesłania. 

 

12. O wyborze Zespołów do Konkursu Organizator poinformuje do dnia 23.09.2023 drogą mailową 
Opiekuna Zespołu. Organizator zastrzega, że skontaktuje się jedynie z zakwalifikowanymi do 
Konkursu Zespołami. 
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3. Jury i ocena projektów 
 

1. Zespoły będą oceniane w trakcie poszczególnych etapów Konkursu przez jury wybrane przez 
Organizatora (dalej zwane „Jury”). 

 
2. Do zadań Jury należeć będzie w szczególności: 

● ocena raportów i działań Zespołów, 
● ocena pracy Zespołów podczas Finału Konkursu, 
● ocena prezentacji końcowych wygłaszanych przez Zespoły podczas Finału, 
● wyłonienie do dnia 08.05.2024 najlepszych projektów, 
●  kontrola nad prawidłowym przebiegiem Konkursu. 

 
3. Ocena merytoryczna zostanie dokonana przy uwzględnieniu poniższych kryteriów: 

 

Założenia i 
osiągnięcia 
techniczne 

Wartość 
badawcza 
misji 

 Popularyzacja 
wiedzy o projekcie 

Praca 
zespołowa i 
projektowa 

Jakość 
raportowania 
i prezentacji  Razem 

30% 30% 20% 10% 10% 100% 

 
 

4. Każdy z członków Jury zobowiązany jest do zapoznania się ze wszystkimi Raportami, 
spełniającymi warunki formalne wskazane w Regulaminie. 

 
5. Decyzje Jury i Organizatora są decyzjami ostatecznymi. 

 

4. Etapy Konkursu 
 
 

Etap 1: Zaproszenie do składania zgłoszeń i wybór Zespołów 

Działanie  Termin  

Rozpoczęcie składania zgłoszeń 1 września 2023 r. 

Ostateczny termin składania zgłoszeń  21 września 2023 r.  

Ogłoszenie wybranych Zespołów  22 września 2023 r. 

Etap 2: Szkolenie wprowadzające online dla Uczestników i Opiekunów 

Działanie  Termin 

Szkolenie Wprowadzające Online  25-26 września -  2023 r. 

Etap 3: Budowa CanSatów i testy 
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Działanie  Termin  

Raport 1 (Preliminary Design Review, PDR)  23 października 2023 r. 

Kwalifikacja Zespołów na podstawie PDR 6 listopada 2032 r. 

Warsztaty Techniczne listopad 2023 r. 

Webinarium z Jury (pytania i odpowiedzi) 9 stycznia 2024 r. 

Raport 2 (Critical Design Review, CDR)   6 lutego 2024 r. 

Komentarz od Jury do Raportu 2 CDR 20 lutego2024 r.  

Raport 3 (Final Design Review, FDR) 25 marca 2024 r. 

Kwalifikacja Zespołów do Finału Konkursu do 2 kwietnia2024 r. 

Spotkanie online z Jury dla Finalistów 5 kwietnia 2024 r. 

Etap 4: Finał Konkursu 

Działanie Termin 

Kampania Startowa 20-21 kwietnia 2024 r. 

Finały Online z prezentacjami misji 27 kwietnia 2024 r. 

 

Terminy i lokalizacje mogą ulec zmianie, o czym Organizator będzie informował Opiekunów na bieżąco 
za pośrednictwem poczty elektronicznej. Terminy nadsyłania raportów rozumiane są jako do końca 
wskazanego dnia, co oznacza do godziny 23:59 wskazanego dnia. 
 

5. Przebieg Konkursu 

5.1. Szkolenie Wprowadzające 

1. Zanim Zespoły rozpoczną pracę nad swoimi projektami, organizowane jest szkolenie 
wprowadzające dla Uczestników i Opiekunów. Szkolenie odbędzie się online na wskazanym przez 
Organizatora komunikatorze.  

 
2. Warunkiem uczestnictwa w Szkoleniu Wprowadzającym jest zakwalifikowanie się Zespołu do 

Konkursu. 
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5.2. Projekt misji - Raport 1 (PDR) 
 

1. Po warsztatach wprowadzających Zespoły pracują nad projektem misji swojego CanSata tworząc 

Raport 1 PDR (z ang. Preliminary Design Review). 

2. Raport powinien być sporządzony wyłącznie w języku angielskim.  

3. Raport 1 PDR powinien mieć nie więcej niż 20 stron A4, w tym może zawierać dokumentację 

fotograficzną, wykresy, ryciny, linki do materiałów audiowizualnych i inne formy prezentacji 

projektu misji CanSata. Minimalny rozmiar czcionki to 11 punktów PostScript (MS Word wielkość 

czcionki min. 11, Tex/LaTex min. 11 bp). 

4. Raporty 1 PDR powyżej 20 stron A4 nie będą oceniane przez Jury i tym samym Zespół nie będzie 

uczestniczył dalej w Konkursie. 

5. Termin nadsyłania Raportu 1 PDR upływa 23.10.2023 r. Raporty nadesłane po tym terminie nie 

będą przyjmowane i tym samym Zespół nie będzie dalej uczestniczył w Konkursie. 

6. Raport 1 PDR i wszystkie jego załączniki powinny być przesłane w jednym pliku w formacie PDF 

na wskazany przez Organizatora adres e-mail. 

7. Na podstawie Raportu 1 PDR zostaną wyłonione Zespoły, które przejdą do dalszego etapu 

Konkursu, o czym Opiekunowie zakwalifikowanych Zespołów zostaną poinformowani drogą 

mailową  

8. Kryteria oceny Raportu 1 PDR zostały podane w Rozdziale 3 pkt. 3. 

5.3. Warsztaty Techniczne 

 

1. Warunkiem uczestnictwa w Warsztatach Technicznych jest zakwalifikowanie się Zespołu na 

podstawie Raportu 1 PDR. 

2. Warsztaty Techniczne odbędą się online w listopadzie 2023 r. na wskazanym przez Organizatora 

komunikatorze. Dokładana data zostanie przekazana zakwalifikowanym Zespołom drogą mailową 

najpóźniej 2 tygodnie przed wydarzeniem. 

5.4. Rozwój projektu - Raport 2 CDR 
 

1. Raport 2 CDR (z ang. Critical Design Review) powinien zostać dostarczony do Organizatora do 
06.02.2024 r. Raporty nadesłane po tym terminie nie będą przyjmowane i tym samym Zespół nie 
będzie dalej uczestniczył w Konkursie.  

2. Raport 2 CDR i wszystkie jego załączniki powinny być przesłane w jednym pliku w formacie PDF. 
3. Raport 3 CDR nie może przekraczać 30 stron A4, w tym może zawierać dokumentację 

fotograficzną, wykresy, ryciny, linki do materiałów audiowizualnych i inne formy prezentacji 

projektu misji CanSata. Minimalny rozmiar czcionki to 11 punktów PostScript (MS Word wielkość 

czcionki min. 11, Tex/LaTex min. 11 bp). 

4. Raport 2 CDR odnosi się do tego samego projektu, co Raport 1 PDR, tylko na innym etapie 
przygotowania, tak więc raport powinien być konstruowany „przyrostowo”. Oznacza to, iż 
pierwszy sporządzony raport powinien być bazą drugiego, itd.  
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5. W każdym z kolejnych raportów na początku powinien znajdować się tzw. Change Log, czyli zapis 
zmian, które nastąpiły względem raportu poprzedniego.  

6. Raport powinien być wypełniony w języku angielskim. 
7. Wszelkie zmiany w składzie Zespołu powinny być uwzględniane w Raporcie 2 CDR.  
8. Kryteria oceny Raportu 2 CDR zostały podane w Rozdziale 3 pkt. 3. 

5.5. Przygotowanie CanSatów do startu - Raport 3 FDR 
 

1. Raport 3 FDR (z ang. Final Design Review) powinien zostać dostarczony do Organizatora do dnia 
25.03.2024 r. na wskazany przez Organizatora adres mailowy. 

2. Raport 3 FDR i wszystkie jego załączniki powinny być przesłane w jednym pliku w formacie PDF. 
3. Raport 3 FDR odnosi się do tego samego projektu co Raport 1 PDR i Raport 2 CDR, tylko na innym 

etapie przygotowania, tak więc raport powinien być konstruowany „przyrostowo”. Oznacza to iż 
pierwszy sporządzony raport powinien być bazą drugiego, itd.  

4. W każdym z kolejnych raportów na początku powinien znajdować się tzw. Change Log, czyli zapis 
zmian, które nastąpiły względem raportu poprzedniego.  

5. Raport powinien być wypełniony w języku angielskim. 
6. Raport 3 FDR powinien mieć nie więcej niż 40 stron A4, w tym może zawierać dokumentację 

fotograficzną, wykresy, ryciny, linki do materiałów audiowizualnych i inne formy prezentacji 

projektu misji CanSata. Minimalny rozmiar czcionki to 11 punktów PostScript (MS Word wielkość 

czcionki min. 11, Tex/LaTex min. 11 bp). 

7. Wszelkie zmiany w składzie Zespołu powinny być uwzględniane w Raporcie 3 FDR. Skład osobowy 
określony w raporcie FDR jest ostatecznym składem dopuszczonym do udziału w Finałach 
Konkursu. 

8. Raport 3 FDR powinien przedstawiać gotowego CanSata, segment naziemny oraz inne 
komponenty niezbędne do wykonania założonych misji minisatelity CanSat. 

9. W raporcie FDR niezbędne jest określenie przez Zespół następujących parametrów Cansata: 
wymiary, masa, szybkość opadania oraz ustawień modułu radiowego (częstotliwość, szerokość 
pasma, moc wyjściową). 

10. Jury może skierować pytania dotyczące Raportu 3 FDR drogą elektroniczną na adres e-mail 
Opiekuna. Zespół ma 48 godzin na udzielenie odpowiedzi drogą mailową na wskazany przez 
Organizatora adres e-mail. 

11. Na podstawie oceny Raportu 3 FDR i odpowiedzi na pytania Jury zostanie wybranych minimum 6 
Zespołów do kolejnego etapu Konkursu. Opiekunowie Zespołów zostaną o tym poinformowani 
drogą mailową do 2 kwietnia 2024r.  

12. Kryteria oceny zostały podane w Rozdziale 3 pkt. 3. 

13. Po zakwalifikowaniu Zespołu do Finału Konkursu, Jury przydzieli częstotliwości radiowe dla 
każdego CanSata. 

14. Treści nadesłanego Raportów 3 Final Design Review (FDR) mogą zostać opublikowane przez 
Organizatora na stronie internetowej ESERO-Polska po zakończeniu Konkursu. Będą one dostępne 
na podanej stronie na warunkach licencji Creative Commons (CC-BY-3.0 PL). Uczestnicy i Opiekun 
wysyłając Raport 3 FDR do Organizatora tym samym zgadzają się na powyższe postanowienie.  

 

https://creativecommons.org/licenses/by/3.0/pl/
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5.6. Finał Konkursu 
 
1. Finał Konkursu składa się z Kampanii Startowej oraz Spotkania Finałowego Online. 
 
2. Kampania Startowa minisatelitów CanSat odbędzie się 20-21 kwietnia 2024 r. 
 
3. Lokalizacja, w której odbędą się zrzuty Cansatów będzie wskazana przez Organizatora najpóźniej 

miesiąc przed wydarzeniem. Informację Opiekunowie dostaną drogą mailową. 
 
4. Ramowy plan Kampanii Starowej: 
 
● procedury formalne i BHP, 
● przygotowania CanSatów do lotu, 
● pytania od Jury, 
● weryfikacja CanSatów przez Jury, 
● zrzut CanSatów z rakiety lub drona (w zależności od warunków atmosferycznych), zebranie 

danych. 
 
5. Spotkanie Finałowe Online odbędzie 27 kwietnia 2024 r. na komunikatorze  

wskazanym przez Organizatora nie później niż na 2 tygodnie przed wydarzeniem. 
 
6. Na Spotkaniu Finałowym Online Zespoły przedstawią wyniki swoich badań. Prezentacje powinny 

trwać nie dłużej niż 15 minut, a dodatkowe 10 minut będzie przeznaczone na pytania od Jury. 
Prezentacje powinny być w języku angielskim. Prezentacje są ostatecznym podsumowaniem misji 
realizowanych przez Zespoły. Następnie Jury po obradach wyłoni najlepsze projekty.  

 
7. Ramowy plan spotkania finałowego: 

● sesja integracyjna, 
● prezentacje Zespołów, 
● obrady Jury, 
● ogłoszenie wyników.. 

 
8. Uczestnicy, którzy będą prezentować misje CanSatów na Spotkaniu Finałowym Online 

zobowiązani są do zapewnienia sobie komputera, dobrego łącza internetowego oraz kamery 
internetowej. 

 
9. Terminy i lokalizacje mogą ulec zmianie, o czym Organizator niezwłocznie poinformuje Opiekunów 

drogą mailową. 
 
10. Do wyłonienia najlepszych projektów posłuży Jury ocena następujących elementów: 
 

● Raport 2 CDR, 
● Raport 3 FDR z podsumowaniem działań promocyjno-edukacyjnych, 
● działalność Zespołu podczas Kampanii Startowej, 
● Prezentacja wygłoszona przez Zespół na Spotkaniu Finałowym Online. 

 
11. Kryteria oceny zostały podane w Rozdziale 3 pkt. 3. 

12. Wyniki Konkursu zostaną ogłoszone przez Jury podczas Spotkania Finałowego Online. 
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6. Minisatelita CanSat - wymagania techniczne i formalne 
 

6.1. Budowa i elementy minisatelitów CanSat 
 

1. Mechanika CanSata. 

 

a. Maksymalne dopuszczalne wymiary CanSata w konfiguracji startowej (do momentu opuszczenia 
zasobnika systemu wynoszenia) są zdefiniowane jako walec o długości 115 mm i średnicy 66 
mm. Wyjątek stanowią spadochron i elastyczne anteny, dla których przewidziana jest 
dodatkowa przestrzeń o geometrii walca o długości nie mniejszej niż 40 mm i średnicy nie 
mniejszej niż 66 mm. Przestrzeń dodatkowa może być przeznaczona wyłącznie na spadochron 
oraz anteny. Dowolne elementy twarde (jak np. śruby mocujące spadochron) muszą zmieścić się 
w przestrzeni głównej, tj. 115 mm x 66 mm. 
 

 

Rys. 1. Definicja maksymalnych wymiarów CanSata i dodatkowych systemów (spadochrony, 
anteny) 
 

b. Niedopuszczalne jest wyposażanie CanSata w spadochron, anteny lub inne elementy w taki 
sposób by powstało wysokie prawdopodobieństwo zaklinowania się ładunku (CanSata) w 
zasobniku.   

c. Wymiary zdefiniowane w Rozdziale 6.1. pkt.1a muszą być samoczynnie utrzymywane przez 
CanSata do momentu opuszczenia zasobnika rakiety/drona. Niedopuszczalne są konstrukcje 
napierające na zasobnik systemu wynoszenia. 

d. Całkowita masa CanSata (włączając w to anteny i spadochron/system odzysku) musi zawierać 
się w przedziale 300-350 g. Lżejsze CanSaty muszą być obciążone dodatkowym balastem do 
osiągnięcia wymaganej masy 300 g.  

 

2. Elektronika CanSata. 

 

a. CanSat musi posiadać własne źródło zasilania. Wymagane jest, aby system był w stanie 
funkcjonować przez co najmniej 4 godziny bez przerwy, wykonując misję podstawową (wraz z 
nadawaniem sygnału radiowego). 

b. Baterie muszą być łatwo dostępne w przypadku konieczności ich szybkiej wymiany w 
warunkach polowych. 
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c. CanSat musi posiadać łatwo dostępny włącznik główny. Włącznik powinien być zabezpieczony 
przed przypadkowym przełączeniem podczas działania przyspieszeń (start rakiety, napełnianie 
spadochronu). 

d. Włączenie CanSata musi być sygnalizowane przy użyciu wizualnej kontrolki (np. diody LED). 
e. Zespół zobowiązany jest do przedstawienia Organizatorowi w dokumencie FDR oraz podczas 

Kampanii Startowej sposobu wyłączenia CanSata (oraz przekazać odpowiednie narzędzia, jeśli 
są potrzebne). Po odnalezieniu CanSat zostanie wyłączony przez Organizatora lub Jury wg 
przekazanej instrukcji, aby zaprzestał on nadawać sygnał radiowy. 

 
3. Łączność radiowa i stacje naziemne. 

 
a. W celu uniknięcia zakłóceń pomiędzy CanSatami, każdemu Zespołowi zakwalifikowanemu do 

Finału Konkursu zostanie przyznane pasmo radiowe o szerokości minimum 125 kHz w paśmie 
ogólnodostępnym ISM 433 MHz. Pasmo może być wykorzystywane do obustronnej 
komunikacji CanSat – stacja naziemna. 

b. Maksymalna moc sygnału na wyjściu modułu radiowego w CanSacie i stacji naziemnej nie 
może przekraczać 20 dBm. 

c. Zmiana pasma, jego szerokości, mocy maksymalnej lub wykorzystywanego modułu radiowego 
(innego niż SX127[6-9]/RFM9[5-6]/CanSat Kit) będzie wymagała zgody Organizatora. Moduł 
radiowy zestawu CanSat Kit jest kompatybilny z wymaganiami dotyczącymi częstotliwości, 
pasma i mocy nadawania, pod warunkiem zastosowania prawidłowej konfiguracji przekazanej 
w jego instrukcji obsługi i materiałach z warsztatów wprowadzających CanSat. 

d. Łącze radiowe powinno pozwalać na odbieranie danych misji podstawowej CanSata 
przynajmniej w odległości 1 km od CanSata (przy ziemi). Zalecany zasięg przy ziemi to 3 km.  

 

4. System odzysku 

 
a. CanSat powinien być wyposażony w system odzysku wielokrotnego użytku, np. spadochron. 

Zaleca się stosowanie materiałów o jaskrawych kolorach, które ułatwiają znalezienie CanSata 
po lądowaniu. 

b. Zalecana szybkość opadania CanSata wynosi 8 - 11 m/s. Ze względów bezpieczeństwa, 
szybkość opadania nie może przekraczać zakresu 5 - 12 m/s. Mniejsza szybkość opadania 
powoduje znaczne oddalenie się CanSata od miejsca startu co może mieć wpływ na 
komunikację radiową oraz zmniejszyć szanse na odnalezienie minisatelity po lądowaniu. W 
raportach należy przedstawić obliczenia lub wyniki testów dotyczących szybkości opadania 
osiąganych za pomocą wybranego systemu odzysku. 

c. CanSat oraz system odzysku powinny być odporne na duże przeciążenie – nawet do 20 g. 
 
 
5. Wymagania systemowe 
 

Minisatelita CanSat oraz segment naziemny muszą być zdolne do realizacji misji podstawowej, 
zgodnie z jej definicją w punkcie 6.8.1, oraz misji dodatkowej, zdefiniowanej przez Zespół. 
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6.2.Budżet CanSata 
 

1. Całkowita wartość komponentów użytych do budowy lotnego CanSata nie może przekroczyć 
500 EUR. 

 
2. W przypadku wykorzystania zestawu CanSat Kit, w budżecie należy przyjąć następujące kwoty 

jego składowych: 
a. płytka główna - 175 zł, 
b. płytka prototypowa - 20 zł, 
c. czujnik temperatury LM35 - 23 zł, 
d. czujnik ciśnienia BMP280 - 10 zł. 

 
3. W przypadku podzespołów uzyskanych w ramach sponsoringu Zespół powinien uwzględnić ich 

koszt w budżecie na podstawie cen rynkowych. 
4. Wydatki związane ze stacją naziemną i innymi komponentami, które nie są integralną częścią 

lotnego CanSata nie są wliczane do podanego limitu kwotowego. 
 

6.3.Bezpieczeństwo 
 

1. Nie dopuszcza się wykorzystywania lub działania na szkodę zwierząt w misji CanSata (zarówno 
w trakcie przygotowań, jak i podczas Kampanii Startowej). 

2. Zakazuje się stosowania materiałów wybuchowych, detonatorów, artykułów pirotechnicznych 
lub mogących stwarzać niebezpieczeństwo, a także wzniecania ognia na pokładzie CanSata lub 
w stacji naziemnej. Wszystkie materiały stosowane do budowy CanSata muszą być bezpieczne 
dla ludzi i środowiska. W przypadku wątpliwości związanych z bezpieczeństwem, Organizator 
może wymagać przedstawienia kart charakterystyki materiału. 

 
3. Wykorzystanie wszelkiego rodzaju zbiorników ciśnieniowych wymaga akceptacji Organizatora. 
4. Stosowanie akumulatorów typu litowo-polimerowych (Li-Pol) wymaga akceptacji Organizatora 

ze względu na zagrożenie pożarowe. 
5. Wznoszenie masztów antenowych i innych konstrukcji wyższych niż 2 (dwa) m lub 

umieszczonych na wysokości powyżej 2 (dwóch) metrów od poziomu ziemi podczas Kampanii 
Startowej będzie wymagało zgody Organizatora. 

6. Jeśli Organizator stwierdzi ze CanSat może stworzyć zagrożenie dla innych minisatelitów, 
platformy startowej lub Uczestników Konkursu nie zostanie dopuszczony do lotu w czasie 
Kampanii Startowej.  

 

6.4. Zalecenia dodatkowe 

 

1. Prawdopodobieństwo odnalezienia CanSata można zwiększyć dzięki: 

− nadawaniu sygnału radiowego przez dłuższy czas (zalecane 6 godzin), 
− użyciu odbiornika nawigacji satelitarnej w minisatelicie CanSat, 



 

14 

 

− użyciu głośnych brzęczyków (ang. buzzerów), 
− wykorzystaniu materiałów w jaskrawych kolorach (obudowa, spadochron). 

 
2. Zaleca się, aby CanSat był podpisany nazwą Zespołu wraz z danymi kontaktowymi (np. numer 

telefonu) w widocznym miejscu na obudowie w przypadku podjęcia CanSata przez osoby 
trzecie. 

 

6.5. Wymagania do Konkursu na szczeblu europejskim  
 

Minisatelita CanSat biorący udział w Konkursie na szczeblu europejskim musi być zgodny z 
aktualnymi wymaganiami opublikowanymi przez ESA (European Space Agency), na stronie 
internetowej  https://cansat.esa.int 

 

6.7. Kampania Startowa 
 
1. CanSaty biorące udział w finałach Konkursu będą wynoszone za pomocą rakiety na wysokość 

między 1,5 a 2,5 km lub/i za pomocą drona na wysokość do 500 m.  
2. Rodzaj systemu wynoszenia użytego podczas Kampanii Startowej i jego osiągi będą zależeć od 

aktualnych warunków atmosferycznych, zagrożenia pożarowego oraz innych czynników 
organizacyjnych.  

3. Zmiana systemu wynoszenia lub jego parametrów może nastąpić w dowolnym momencie, 
nawet podczas Kampanii Startowej.  

4. Jeśli dojdzie do zmiany systemu wynoszenia lub jego parametrów Jury weźmie ten czynnik pod 
uwagę w procesie oceny. 

5. Parametry systemów wynoszenia oraz zasobników na CanSaty zostaną udostępnione 
Opiekunom nie później niż na miesiąc przed Kampanią Startową. 

6. Podczas Kampanii Startowej Jury przeprowadzi następującą weryfikację CanSatów: 
a. Gotowość do lotu i wykonania misji będzie określana na podstawie rozmów Jury z 

Zespołami, 
b. Pomiar masy CanSata dokonywany będzie za pomocą wagi o dokładności nie gorszej niż 

+/- 1 g. Wynik pomiaru nie może wykraczać poza podany w pkt. 6.1.1 d przedział +/- 
dokładność wagi. 

c. Pomiary wymiarów zewnętrznych CanSata dokonywane będą za pomocą przyrządu  
o dokładności pomiaru nie gorszej niż 0.1 mm. Wynik pomiaru nie może wskazywać 
wymiarów większych niż zdefiniowane w 6.1.1 a +/- dokładność przyrządu. 

 
7. Podczas Kampanii Startowej Jury będzie weryfikować poprawność ustawień nadajników 

radiowych (częstotliwość środkową, zajmowane pasmo, moc sygnału). 
8. CanSaty niespełniające wymagań z Rozdziału 6 nie będą dopuszczone do lotu podczas 

Kampanii Startowej przez Jury lub Organizatora, z wyłączeniem pkt 6.9. 

https://cansat.esa.int/
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6.8. Misja podstawowa i dodatkowa 
 

6.8.1.Misja podstawowa 
 

1. Zespół musi zbudować CanSata i zaprogramować go w taki sposób, aby zrealizował 
podstawową, obowiązkową misję, która brzmi:  
 
Po starcie, w trakcie opadania i po lądowaniu, CanSat ma za zadanie mierzyć, zapisywać na 
karcie SD/microSD i przesyłać do stacji naziemnej (przynajmniej raz na sekundę) następujące 
dane telemetryczne: 

● temperatura powietrza otoczenia (poza obudową satelity), 
● ciśnienie atmosferyczne, 

a Zespół ma następnie te dane przeanalizować. 
 

2. Zespół musi mieć możliwość późniejszego przeanalizowania uzyskanych danych (na przykład, 
do obliczenia wysokości) i następnie przedstawienia ich w formie graficznej na wykresach (na 
przykład zmiana wysokości w czasie lub zmiana temperatury w zależności od wysokości). 

3. Zespół powinien określić i przedstawić zastosowanie zebranych danych w ramach misji 
podstawowej. 

6.8.2.Misja dodatkowa 
 

1. Każdy Zespół musi wybrać i zdefiniować misję dodatkową CanSata. 
 

2. Zespoły mają dowolność w wyborze rodzaju misji dodatkowej. 
 

3. Misja dodatkowa powinna mieć wartość naukową, techniczną lub stanowić innowację.  
 

4. Inspiracją do wybrania misji dodatkowej mogą być misje sond kosmicznych, w tym satelitów, 
zapotrzebowanie na dane naukowe potrzebne do realizacji konkretnego projektu naukowego, 
czy też pokazanie możliwości technicznych podzespołu lub rozwiązania zaprojektowanego 
przez Zespół. Warto też zastanowić się jaka misja mogłaby zidentyfikować bądź przyczynić się 
do rozwiązania konkretnych problemów występujących w środowisku lub społeczeństwie. 
Przykładami misji dodatkowych są: zaawansowana telemetria, zdalna kontrola CanSata, 
obrazowanie satelitarne, kontrola lotu. 

 
5. Misja dodatkowa powinna być tak dobrana i zaprojektowana, aby była możliwa do realizacji  

w warunkach panujących podczas Kampanii Startowej. 
 

6. Zespoły powinny wziąć pod uwagę ograniczenia związane z profilem misji minisatelity CanSat 
i skoncentrować się na wykonalności wybranej przez siebie misji (zarówno pod względem 
technicznym, jak i finansowym lub logistycznym). 

 
7. Zmiana lub odstępstwo od stosowania konkretnych wymagań (w konkretnym, wskazanym 

przez Zespół przypadku) zostanie rozpatrzona przez Organizatora i Jury na podstawie wniosku 
z uzasadnieniem złożonego przez Zespół na wskazany przez Organizatora adres e-mail przed 
złożeniem Raportu 3 FDR. Decyzja dotycząca wniosku zostanie udzielona drogą e-mailową na 
adres Opiekuna. 
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7. Kwestie finansowe 

 
 

1. Organizator zapewnia: 
a. Jeden zestaw CanSat Kit dla każdego Zespołu, który przejdzie do kolejnego etapu Konkursu na 

podstawie Raportu 1 PDR (zawierający dwie płytki – do CanSata i do stacji naziemnej oraz 
czujniki misji podstawowej, opis CanSat Kit znajduje się pod adresem: 
https://github.com/CanSatKit/Documentation). 

b. Zwrot kosztów dojazdu do kwoty 800 zł/Zespół do lokalizacji, w której odbędzie się Kampania 

Startowa, wybranej przez Organizatora Zwrot kosztów podróży na warunkach określonych 

poniżej, nastąpi najpóźniej w terminie do 3 miesięcy od dnia zakończenia finałów krajowych 

Konkursu, w drodze przelewu na numer rachunku bankowego wskazany przez Opiekuna lub 

Uczestnika Konkursu. Za dzień dokonanego zwrotu kosztów podróży przyjmuje się dzień 

obciążenia rachunku bankowego Organizatora. Warunkiem zwrotu kosztów podróży jest 

przedstawienie biletów lub wypełnienie karty ewidencji przejazdu przekazanej przez 

Organizatora. 

c. Nagrody rzeczowe lub pieniężne dla Uczestników zakwalifikowanych do Finałów Konkursu. 

Nagrody, o których mowa w niniejszym punkcie zostaną przekazane przez Organizatora 

Opiekunom zwycięskich Zespołów na podstawie listy członków Zespołu przesłanej do 

Organizatora. Opiekunowie następnie przekażą nagrody członkom Zespołów. Przekazanie 

nagród pieniężnych nastąpi najpóźniej w terminie do 3 miesięcy od dnia zakończenia finałów 

krajowych Konkursu, w drodze przelewu na numer rachunku bankowego wskazany przez 

Opiekuna. 

 

2. Wydatki, które muszą zostać pokryte przez Zespół (lub szkołę, sponsorów, itp.): 
a. Wszelkie dodatkowe urządzenia elektroniczne i materiały konieczne do budowy i realizacji 

misji CanSata. 
b. Wszelkie inne koszty poniesione przez Zespół niewymienione powyżej jako zapewnione przez 

Organizatora. 
 
 

8. Ochrona danych osobowych 

1. Warunkiem udziału w Konkursie jest wypełnienie i zapisanie internetowego Formularza oraz 
wyrażenie przez Opiekuna zgody na przetwarzanie przez Organizatora podanych w Formularzu 
danych osobowych zgodnie z Rozporządzeniem Parlamentu Europejskiego i Rady (UE) 
2016/679 z dnia 27 kwietnia 2016 r. w sprawie ochrony osób fizycznych w związku z 
przetwarzaniem danych osobowych i w sprawie swobodnego przepływu takich danych oraz 
uchylenia dyrektywy 95/46/WE (ogólne rozporządzenie o ochronie danych, Dz. Urz. UE L 119 z 
04.05.2016 r.) oraz wydanymi na jego podstawie krajowymi przepisami z zakresu ochrony 
danych osobowych. 

2. Administratorem danych osobowych podanych przez Opiekuna jest Organizator, którego pełna 
nazwa i siedziba zostały wskazane w pkt 1 ppkt 1 Regulaminu. 

https://github.com/CanSatKit/Documentation
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3. Dane osobowe są zbierane na zasadzie dobrowolności, jednakże podanie danych w zakresie 
określonym w Formularzu jest warunkiem wzięcia udziału w Konkursie, na podstawie art. 6 ust. 
1 lit. a) ogólnego rozporządzenia o ochronie danych osobowych z dnia 27 kwietnia 2016 r., tj. 
na podstawie zgody osoby, której dane dotyczą. 

4. Dane osobowe przetwarzane będą wyłącznie dla celów organizacji i przeprowadzenia 
Konkursu, w szczególności komunikacji z Opiekunem, wyłonienia Zespołów zwycięskich oraz 
ogłoszenia wyników Konkursu. Opiekun zgłaszający Zespół do Konkursu jest podaje 
następujące dane w Formularzu: imię, nazwisko, adres e-mail oraz telefon kontaktowy, adres 
pocztowy instytucji lub siedziby, liczbę członków Zespołu 

5. Dane osobowe przetwarzane będą do dnia 31 października 2026 r., z zastrzeżeniem ppkt 15 
poniżej. 

6. Dane osobowe mogą być udostępniane podmiotom świadczącym usługi na rzecz Organizatora 
oraz podmiotom uprawnionym na podstawie przepisów prawa.  

7. Każdy Opiekun ma prawo dostępu do swoich danych, może je sprostować, usunąć lub 
ograniczyć ich przetwarzanie. Może też cofnąć zgodę na przetwarzanie danych poprzez 
przesłanie takiej informacji na adres siedziby CNK lub na adres e-mail: esero@kopernik.org.pl., 
co nie będzie miało wpływu na zgodność z prawem przetwarzania, którego dokonano przed 
cofnięciem zgody. Ma także prawo do przenoszenia danych.  

8. Osobie, której dane dotyczą, nie przysługuje prawo do sprzeciwu wobec przetwarzania jej 
danych z uwagi na fakt, że podstawą przetwarzania jest art. 6 ust. 1 lit. a) ogólnego 
rozporządzenia o ochronie danych osobowych z dnia 27 kwietnia 2016 r.  

9. Opiekun może wnieść skargę na postępowanie Organizatora do organu nadzorczego – Urzędu 
Ochrony Danych Osobowych, ul. Stawki 2, 00-193 Warszawa.   

10. Podanie danych osobowych jest dobrowolne, jest jednak warunkiem niezbędnym do 
uczestnictwa w Konkursie. 

11. Decyzje dotyczące podanych przez Opiekuna danych osobowych nie będą podejmowane w 
sposób zautomatyzowany. 

12. Uczestnik może skontaktować się z CNK, w tym z osobą pełniącą w CNK obowiązki inspektora 
ochrony danych, pisząc pod adres siedziby CNK lub wysyłając wiadomość elektroniczną pod  
adres e-mai:  esero@kopernik.org.pl.   

13. Organizator nie ponosi odpowiedzialności za skutki podania błędnych danych osobowych przez 
Uczestnika. 

14. W przypadku, gdy Zespół zakwalifikowany zostanie do Finału Konkursu, wymagane będzie 
podanie przez Uczestników danych umożliwiających udział w Finale Konkursu na poligonie 
wojskowym lub na lotnisku, na podstawie odrębnej zgody na przetwarzanie danych, po 
uprzednim zapoznaniu się z klauzulą informacyjną dotyczą przetwarzania danych.  

15. Ponadto, Opiekun może dobrowolnie wyrazić zgodę na przetwarzanie przez Organizatora 
podanych w Formularzu danych osobowych Opiekuna w celu przesyłania Opiekunowi 
informacji o innych działaniach ESERO.  W przypadku wyrażenia takiej zgody, dane osobowe 
Opiekuna będą przetwarzane na podstawie art. 6 ust. 1 lit. a) ogólnego rozporządzenia o 
ochronie danych osobowych z dnia 27 kwietnia 2016 r., tj. na podstawie zgody osoby, której 
dane dotyczą. Dane osobowe Opiekuna będą przetwarzane do momentu cofnięcia tej zgody. 
W zakresie nieokreślonym w niniejszym podpunkcie, postanowienia niniejszego punktu 
stosuje się odpowiednio. 
 
 
 
 

mailto:esero@kopernik.org.pl
mailto:esero@kopernik.org.pl
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9. Postanowienia końcowe

1. Wszelkie pytania i deklaracje zainteresowania należy kierować na następujący adres e-mail: 
cansat@kopernik.org.pl 

2. Niniejszy Regulamin oraz Formularz dostępne są na stronie internetowej ESERO-Polska. 
3. Przesłanie wypełnionego Formularza jest jednoznaczne z pełną akceptacją postanowień 

Regulaminu. 
4. Organizator nie ponosi odpowiedzialności za skutki działania siły wyższej, w szczególności w 

przypadku odwołania lub zmiany terminów przeprowadzania Konkursu z powodu działania siły 
wyższej. Za siłę wyższą uznaje się zdarzenie będące poza kontrolą Organizatora, które 
powoduje, że wykonanie zobowiązań jest niemożliwe lub może być uznane za niemożliwe ze 
względu na występujące okoliczności. Siłę wyższą stanowią w szczególności: warunki 
atmosferyczne, awarie lub zakłócenia pracy urządzeń dostarczających energię elektryczną, 
zamieszki, powodzie, wyładowania atmosferyczne, wybuchy, pożar, strajki, działania organów 
władzy, w tym dotyczące zagrożenia wywołanego działaniem koronawirusa SARS-CoV 2. 

5. Organizator zastrzega sobie prawo zmiany Regulaminu z ważnych przyczyn, o czym 
niezwłocznie poinformuje Opiekunów za pośrednictwem poczty elektronicznej. 

6. Terminy i lokalizacje wskazane w Regulaminie mogą ulec zmianie, o czym Organizator będzie 
informował Opiekunów na bieżąco za pośrednictwem poczty elektronicznej.  

7. W sprawach nieuregulowanych Regulaminem mają zastosowanie przepisy Kodeksu cywilnego 
i inne przepisy prawa powszechnie obowiązującego. 

8. Wszelkie spory mogące wyniknąć w wyniku przebiegu Konkursu będą rozpatrywane przez sąd 
właściwy dla siedziby Organizatora. 

10. SARS-COV-2 

1. Jeśli na terenie Polski będzie obowiązywał stan epidemii albo stan zagrożenia 
epidemiologicznego z uwagi na wirus SARS-COV-2, informujemy, że Państwa dane, podawane 
podczas zgłaszania udziału w Konkursie (w zakresie imię i nazwisko, telefon/ e-mail podany do 
kontaktu lub dotyczy danych podawanych podczas rejestracji) mogą być przetwarzane również 
na podstawie art. 6 ust 1 lit d) oraz art. 9 ust 2 lit i) RODO.  

2. W przypadku wystąpienia objawów infekcji u Opiekuna Uczestnika Konkursu lub u Uczestnika 
Konkursu, Opiekun jest zobowiązany poinformować Organizatora, o rezygnacji z udziału w 
Konkursie. 

3. Opiekun oraz Uczestnicy Konkursu są zobowiązani, do przestrzegania aktualnych przepisów 
dotyczących obostrzeń i nakazów wprowadzonych przez przepisy prawa oraz wytycznych 
związanych z wprowadzonym stanem epidemii, publikowanych na stronie Ministerstwa 
Zdrowia oraz Głównego Inspektoratu Sanitarnego. 

mailto:cansat@kopernik.org.pl


 
 

1 

 
 

Dokumentacja zestawu 
startowego CanSat Kit 

 

 

 

 

 

 

 

Rewizja dokumentu: v1.5 (2020-10-26) 

Dotyczy zestawu CanSat Kit rev. 1.2 

  



 
2 

1 Spis treści 
 

2 Przeznaczenie zestawu ................................................................................................................................. 4 

3 Elementy zestawu ........................................................................................................................................ 4 

4 Parametry techniczne .................................................................................................................................. 5 

4.1 Płytka główna CanSata / stacji naziemnej .......................................................................................... 5 

4.1.1 Informacje ogólne ........................................................................................................................... 5 

4.1.2 Mapa złącz, gniazd i diod LED ......................................................................................................... 6 

4.1.3 Źródła i metody zasilania płytki .................................................................................................... 14 

4.1.4 Układ zasilania ............................................................................................................................... 15 

4.1.5 Mikrokontroler .............................................................................................................................. 16 

4.1.6 Czytnik kart microSD ..................................................................................................................... 17 

4.1.7 Moduł radiowy .............................................................................................................................. 17 

4.1.8 Parametry mechaniczne ................................................................................................................ 18 

4.2 Czujnik temperatury .......................................................................................................................... 20 

4.2.1 Parametry pomiarowe .................................................................................................................. 20 

4.2.2 Zasilanie ......................................................................................................................................... 20 

4.2.3 Interfejs .......................................................................................................................................... 20 

4.2.4 Pinout ............................................................................................................................................. 20 

4.2.5 Parametry mechaniczne ................................................................................................................ 21 

4.3 Czujnik ciśnienia atmosferycznego ................................................................................................... 21 

4.3.1 Parametry pomiarowe .................................................................................................................. 21 

4.3.2 Zasilanie ......................................................................................................................................... 22 

4.3.3 Interfejs .......................................................................................................................................... 22 

4.3.4 Pinout ............................................................................................................................................. 22 

4.3.5 Parametry mechaniczne ................................................................................................................ 22 

5 Uruchomienie zestawu .............................................................................................................................. 23 

5.1 Instalacja i konfiguracja środowiska Arduino IDE ............................................................................ 23 

5.2 Podłączanie płytki do komputera za pomocą portu USB ................................................................. 27 

5.3 Wgranie pierwszego programu „Hello CanSat” ............................................................................... 28 

5.4 Podłączenie i testy czujnika temperatury ......................................................................................... 30 

5.5 Podłączenie i testy czujnika ciśnienia ............................................................................................... 31 



 
3 

5.6 Używanie karty micro SD .................................................................................................................. 32 

5.7 Używanie modułu radiowego ........................................................................................................... 34 

5.7.1 Konfiguracja nadajnika .................................................................................................................. 34 

5.7.2 Konfiguracja odbiornika ................................................................................................................ 35 

5.8 Podłączenie anten ............................................................................................................................. 36 

6 Zestaw analogiczny .................................................................................................................................... 37 

6.1 Lista elementów zestawu analogicznego ......................................................................................... 37 

6.2 Podłączenie modułów ....................................................................................................................... 38 

6.3 Różnice i ograniczenia ....................................................................................................................... 38 

7 Bezpieczeństwo i zasady prawidłowego użytkowania ............................................................................. 39 

 

  



 
4 

2  Przeznaczenie zestawu 
 

Zestaw startowy CanSat Kit zaprojektowany został jako platforma do budowy minisatelity CanSat 

oraz stacji naziemnej zgodnych z wymaganiami konkursu „CanSats in Europe” oraz polskich 

zawodów CanSat organizowanych przez ESERO-PL. 

     

Przed użyciem zestawu należy zapoznać się z niniejszym dokumentem, 
w szczególności z rozdziałem 7. Bezpieczeństwo i zasady prawidłowego użytkowania. 

 

3 Elementy zestawu 

 

Zestaw zawiera wszystkie niezbędne komponenty elektroniczne do wypełnienia misji 

podstawowej minisatelity CanSat: moduł zasilania (bez akumulatora/baterii), komputer 

pokładowy, moduły łączności bezprzewodowej, a także czujniki temperatury i ciśnienia 

atmosferycznego.  

Obudowa minisatelity CanSat, system odzysku (np. spadochron) oraz akumulator/bateria 

zasilająca powinny zostać wykonane/dodane przez użytkownika zestawu według wymagań 

danego minisatelity. 

 

Zestaw CanSat Kit składa się z następujących elementów: 

• 2 x płytka główna CanSata / stacji naziemnej 

• 1 x płytka drukowana prototypowa 

• 1 x czujnik temperatury LM35 

• 1 x czujnik ciśnienia BMP280 

• 2 x kabel mini USB 

• 1 x złącze antenowe SMA 

• 1 x listwa kołkowa 2x40-pin 2.54 mm 

• 2 x złącze śrubowe typu terminal block 2.54 mm 

• 1 x płytka stykowa 
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• 8 x kabel do płytki stykowej 

• 1 x opakowanie ESD 

4 Parametry techniczne 
 

4.1 Płytka główna CanSata / stacji naziemnej 
 

 

 

4.1.1 Informacje ogólne 
 

Płytka główna dedykowana jest do użycia zarówno w minisatelicie CanSat, jak i w stacji naziemnej 

do odbioru danych drogą radiową. 

Płytka główna składa się z następujących bloków: 
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• układ zasilania – umożliwia zasilenie płytki i urządzeń zewnętrznych z pojedynczego 

ogniwa baterii litowo-jonowej lub innych ogniw o napięciach 2.5 – 5.0 V; 

• komputer pokładowy – mikrokontroler zgodny z Arduino M0, z możliwością 

programowania przez port USB; 

• magazyn danych – złączę na kartę microSD, dostępne z poziomu komputera 

pokładowego; 

• moduł łączności bezprzewodowej – układ radiowy nadawczo-odbiorczy, oparty o 

standard LoRa, z zewnętrznym złączem antenowym. 

 

4.1.2 Mapa złącz, gniazd i diod LED 
 

 
Tabela 1. Złącza, gniazda i diody LED płytki głównej / stacji naziemnej 

 

 

 

 

 



 
7 

Nazwa złącza Opis i funkcje 

BAT (J4) 

• złącze zasilania zewnętrznego (np. z baterii): 2.5 – 5.0 V, 

• raster 2.5 mm,  

• możliwość wlutowania złącza typu listwa kołkowa (header), 

śrubowego (terminal block) lub przylutowania przewodów (ze stress 

reliefem). 

RBL (J3) 
• zworka zasilania, 

• możliwość wpięcia głównego włącznika, 

mini USB (J5) 

• zasilanie, 

• programowanie mikrokontrolera z Arduino IDE, 

• przesyłanie danych (SerialUSB), 

• po więcej szczegółów zobacz dokumentację Arduino M0 dotyczącą 

złącza USB. 

J1, J2 

• złącze kołkowe żeńskie 2.5 mm, 

• dostępne napięcia zasilające, 

• wyprowadzone wejścia/wyjścia mikrokontrolera. 

micro SD 
• złącze na karty pamięci micro SD, 

• podłączone do mikrokontrolera – zob. 4.1.6. 

ANT 

• złącze anteny modułu radiowego, 

• możliwość przylutowania złącza SMA np. do wkręcenia większej 

anteny (w stacji naziemnej), 

• możliwość przylutowania anteny ćwierćfalowej wykonanej z 

przewodu. 

 

  

https://cdn.sparkfun.com/assets/5/3/b/f/2/526d7970757b7f7f708b4568.jpg
https://cdn.sparkfun.com/assets/5/3/b/f/2/526d7970757b7f7f708b4568.jpg
https://media.rs-online.com/t_large/F6163422-01.jpg
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4.1.2.1 Złącze J1 

 

🛈 

Piny zaznaczone (✓) jako „Arduino M0” są w pełni kompatybilne z płytką Arduino M0. 
Szczegółowe informacje o właściwościach i wykorzystaniu tych pinów są dostępne 
w dokumentacji Arduino M0: https://store.arduino.cc/arduino-m0 

  

     

Standard napięć dla pinów mikrokontrolera to 3.3 V.  
Podłączenie urządzeń pracujących w innych standardach napięciowych (np. 5 V) 
może skutkować uszkodzeniem zestawu. 

 

 

 

 

https://store.arduino.cc/arduino-m0
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Tabela 2. Mapa pinów złącza J1 

Pin nr Nazwa 
Arduino 

M0 
Opis 

Użycie w Arduino IDE 

wejście / 
wyjście 
cyfrowe 

wejście 
analogowe 

wyście 
analogowe 

inne funkcje 

1 +5 V  Zasilanie + 5 V - - - - 

2 +5 V  Zasilanie + 5 V - - - - 

3 SCL2 ✓ Interfejs I2C – linia SCL (clock) 17 - - I2C – Wire lib 

4 SDA2 ✓ Interfejs I2C – linia SDA (data) 16 - - I2C – Wire lib 

5 SWCLK  
pin do programowania przy użyciu 
zewnętrznego programatora 

- - - - 

6 SWDIO  
pin do programowania przy użyciu 
zewnętrznego programatora 

- - - - 

7 D1 ✓ 

Generalnego przeznaczenia – 
wejście/wyjście cyfrowe (GPIO) 
Serial port TX: w Arduino IDE jako 
Serial1 

1 - - Serial1 (TX) 

8 D0 ✓ 

Generalnego przeznaczenia – 
wejście/wyjście cyfrowe (GPIO) 
Serial port RX: w Arduino IDE jako 
Serial1 

0 - - Serial1 (RX) 

9 D3 ✓ 
Generalnego przeznaczenia – 
wejście/wyjście cyfrowe (GPIO) 

3 - 3 - 

10 D2 ✓ 
Generalnego przeznaczenia – 
wejście/wyjście cyfrowe (GPIO) 

2 - 2 - 

https://www.arduino.cc/reference/en/language/functions/digital-io/digitalread/
https://www.arduino.cc/reference/en/language/functions/digital-io/digitalwrite/
https://www.arduino.cc/reference/en/language/functions/analog-io/analogread/
https://www.arduino.cc/reference/en/language/functions/analog-io/analogread/
https://www.arduino.cc/reference/en/language/functions/analog-io/analogwrite/
https://www.arduino.cc/reference/en/language/functions/analog-io/analogwrite/
https://www.arduino.cc/en/Reference/Wire
https://www.arduino.cc/en/Reference/Wire
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11 D5 ✓ 
Generalnego przeznaczenia – 
wejście/wyjście cyfrowe (GPIO) 

5 - 5 - 

12 D4 ✓ 
Generalnego przeznaczenia – 
wejście/wyjście cyfrowe (GPIO) 

4 - 4 - 

13 A1 ✓ 
Wejście/wyjście cyfrowe (GPIO), wejście 
analogowe (ADC) 

A1 A1 - - 

14 A0 ✓ 

Wejście/wyjście cyfrowe (GPIO), wejście 
analogowe (ADC), wyjście analogowe 
(DAC) 

A0 A0 A0 - 

15 A3 ✓ 
Wejście/wyjście cyfrowe (GPIO), wejście 
analogowe (ADC) 

A3 A3 - - 

16 A2 ✓ 
Wejście/wyjście cyfrowe (GPIO), wejście 
analogowe (ADC) 

A2 A2 - - 

17 A5 ✓ 
Wejście/wyjście cyfrowe (GPIO), wejście 
analogowe (ADC) 

A5 A5 - - 

18 A4 ✓ 
Wejście/wyjście cyfrowe (GPIO), wejście 
analogowe (ADC) 

A4 A4 - - 

19 AREFA ✓ 
Zewnętrzne napięcie referencyjne dla 
przetwornika ADC (opcjonalnie) 

- - - - 

20 GND ✓ Masa - - - - 

 

https://blog.arduino.cc/2010/12/13/tutorial-arduino-and-the-aref-pin/
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4.1.2.2 Złącze J2 
 

🛈 

Piny zaznaczone (✓) jako „Arduino M0” są w pełni kompatybilne z płytką Arduino M0. 
Szczegółowe informacje o właściwościach i wykorzystaniu tych pinów są dostępne 
w dokumentacji Arduino M0: https://store.arduino.cc/arduino-m0 
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Tabela 3. Mapa pinów złącza J2 

Pin nr Nazwa 
Arduino 

M0 
Opis 

Użycie w Arduino IDE 

wejście / 
wyjście 
cyfrowe 

wejście 
analogowe 

wyście 
analogowe 

inne funkcje 

1 +3.3 V  Zasilanie + 3.3 V - - - - 

2 +3.3 V  Zasilanie + 3.3 V - - - - 

3 nRESET ✓ 

Zanegowany reset mikrokontrolera 
(zwarcie z GND powoduje reset 
mikrokontrolera) 

- - - - 

4 Vbat  Napięcie z wejścia Vbat (za zworką RBL) - - - - 

5 SERIAL5_RXD ✓1 
Dodatkowy Serial port RX: w Arduino IDE 
jako Serial 

- - - Serial (RX) 

6 SERIAL5_TXD ✓1 
Dodatkowy Serial port TX: w Arduino IDE 
jako Serial 

- - - Serial (TX) 

7 D6 ✓ 
Generalnego przeznaczenia – 
wejście/wyjście cyfrowe (GPIO) 

6 - - - 

8 D7 ✓ 
Generalnego przeznaczenia – 
wejście/wyjście cyfrowe (GPIO) 

7 - - - 

9 D8 ✓ 
Generalnego przeznaczenia – 
wejście/wyjście cyfrowe (GPIO) 

8 - - - 

10 D9 ✓ 
Generalnego przeznaczenia – 
wejście/wyjście cyfrowe (GPIO) 

9 - - - 

11 D13 ✓ 

Generalnego przeznaczenia – 
wejście/wyjście cyfrowe (GPIO), 
podłączona dioda D13 

13 - - - 

https://www.arduino.cc/reference/en/language/functions/digital-io/digitalread/
https://www.arduino.cc/reference/en/language/functions/digital-io/digitalwrite/
https://www.arduino.cc/reference/en/language/functions/analog-io/analogread/
https://www.arduino.cc/reference/en/language/functions/analog-io/analogread/
https://www.arduino.cc/reference/en/language/functions/analog-io/analogwrite/
https://www.arduino.cc/reference/en/language/functions/analog-io/analogwrite/
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12 MISO2 ✓ 
Interfejs SPI, podłączony czytnik kart SD 
oraz moduł radiowy 

18 - - - 

13 SCK2 ✓ 
Interfejs SPI, podłączony czytnik kart SD 
oraz moduł radiowy 

20 - - - 

14 MOSI2 ✓ 
Interfejs SPI, podłączony czytnik kart SD 
oraz moduł radiowy 

21 - - - 

15 GND ✓ Masa - - - - 

16 GND ✓ Masa - - - - 

 

Przypisy: 

1 – dostępne na Arduino M0 w wersji Wemos SAMD21 M0 

2 – do linii podłączono rezystor podciągający do 3.3 V (pull-up) o rezystancji 15 k 

 

 

 

https://startingelectronics.org/articles/arduino/wemos-arduino-m0/
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4.1.2.3 Diody 
 

Tabela 4. Diody świecące (LED) dostępne na płytce i ich funkcje 

Nazwa diody Opis 

LED D13 

• dioda LED bezpośrednio podłączona do pinu D13 mikrokontrolera, 

• kompatybilna z diodą D13 w Arduino M0 (LED_BUILTIN), 

• po więcej szczegółów zobacz dokumentację Arduino M0. 

LED PWR 

• dioda sygnalizująca obecność napięcia na linii zasilania 3.3 V, 

• obecność napięcia na linii 3.3 V implikuje obecność na linii 5 V (oraz 

VBAT, jeśli zasilanie jest dostarczane przez VBAT). 

LED RX 
• aktywna, gdy płytka odbiera dane przez port SerialUSB (więcej 

szczegółów w dokumentacji Arduino M0) 

LED TX 
• aktywna, gdy płytka wysyła dane przez port SerialUSB (więcej 

szczegółów w dokumentacji Arduino M0) 

 

4.1.3 Źródła i metody zasilania płytki 
 

Płytka główna może być zasilana na kilka różnych sposobów, które zostały przedstawione poniżej: 

1) Złącze zasilające J4 (BAT) 

̶ minimalne napięcie wejściowe: 2.5 V 

̶ maksymalne napięcie wejściowe: 5.0 V 

̶ zasilenie układów płytki ze złącza BAT następuje tylko wtedy, gdy zwarta jest zworka 

oznaczona jako RBL, 

̶ zalecane jest zasilanie płytki z akumulatorów litowo-jonowych (1 cela szeregowo/1S, 3.7 - 

4.3 V), baterii lub akumulatorów 3 x AA/AAA połączone szeregowo (3.6 – 4.5 V). 

 

2) Złącze mini USB (J5) 

̶ maksymalne napięcie wejściowe: 5.5 V 

̶ podłączenie płytki za pomocą złącza mini USB spowoduje zasilenie jej modułów (w tym 

pojawienie się napięcia na liniach zasilających 5 V i 3.3 V na złączu J1 i J2) niezależnie od 

stanu zworki RBL. 

 

3) Złącze kołkowe J2: VBAT (pin 4) oraz GND (piny 15 lub 16) 

̶ minimalne napięcie wejściowe: 2.5 V 
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̶ maksymalne napięcie wejściowe: 5.0 V 

̶ podłączenie płytki za pomocą tego złącza spowoduje zasilenie jej modułów (w tym 

pojawienie się napięcia na liniach zasilających 5 V i 3.3 V na złączu J1 i J2) niezależnie od 

stanu zworki RBL. 

     
Zamiana polaryzacji zasilania powoduje nieodwracalne uszkodzenia na płytce!   

 

     

Podłączenie napięcia większego niż maksymalne napięcie podane w specyfikacji dla 
danego wejścia może spowodować nieodwracalne uszkodzenia na płytce!    

 

 

4.1.4 Układ zasilania 
 

Układ zasilania obecny na płytce odpowiada za konwersję energii elektrycznej, dystrybucję na 

płytce głównej do zasilania jej podzespołów oraz dostarczenie energii do zasilenia układów 

dołączanych do płytki głównej przez użytkownika. 

Układ dostarcza następujące linie zasilania na złączach J1 i J2: 

• linia 5 V 

− napięcie (minimalne, nominalne, maksymalne): 4.7 V, 5.0 V, 5.4 V 

− wydajność prądowa: maksymalnie 0.75 A, zalecana 0.5 A 

 

• linia 3.3 V 

− napięcie (minimalne, maksymalne): 3.0 V, 3.3 V 

− wydajność prądowa: maksymalnie 0.75 A, zalecana 0.5 A 

 

• linia VBAT 

− bezpośrednie, niezabezpieczone napięcie z baterii (za zworką RBL). 

 

     
Sumaryczny pobór prądu z linii 3.3 V i 5 V nie może przekraczać 1 A. 
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W przypadku poboru większego prądu niż podano w specyfikacji dla danej linii, 
zostanie aktywowane zabezpieczenie nadprądowe, które skutkuje odłączeniem linii 
na pewien okres. Cała płytka powinna zostać odłączona od zasilania na kilka minut, 
aby przywrócić napięcie na odłączonej linii. Zabezpieczenie prądowe jest 
realizowane za pomocą bezpieczników typu „polyfuse”. 

 

Zworka RBL 

Zworka RBL jest podłączona szeregowo ze pinem „+” złącza BAT (J4). Zalecane jest podłączenie 

przełącznika do złącza RBL (J3), który będzie pełnił funkcję głównego włącznika CanSata. Jeśli 

przełącznik jest zlokalizowany w innym miejscu, złącze RBL (J3) można zewrzeć na stałe. 

 

     

Zworka ma wpływ tylko i wyłącznie za odłączanie/włączanie źródła zasilania 
podpiętego do złącza BAT (J4). Nie ma ona wpływu, jeśli płytka zasilana jest przez 
złącze miniUSB (J5) oraz przez pin VBAT na złączu J2! 

 

 

4.1.5 Mikrokontroler 
 

Adel ATSAMD21G18 to wydajny, 32-bitowy mikrokontroler z rdzeniem ARM Cortex® M0. 

W 100% zgodny z Arduino M0.  

Parametry techniczne: 

Mikrokontroler ATSAMD21G18, LQFP 48 

Architektura rdzenia ARM Cortex-M0+ 

Napięcie pracy 3.3V 

Pamięć Flash 256 KB 

Pamięć SRAM 32 KB 

Częstotliwość zegara 48 MHz 
 

Dostępne dla użytkownika interfejsy zostały wymienione w tabelach 4.1.2.1 oraz 4.1.2.2. 

 

     

Pobór prądu z każdego pinu mikrokontrolera: 

• maksymalnie 10 mA 

• rekomendowane 7 mA   
 

https://store.arduino.cc/arduino-m0
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Sumaryczny pobór prądu z pinów w obrębie jednej grupy zasilania maksymalnie 
65 mA.  Zobacz dokumentację mikrokontrolera. 

 

     

Sumaryczny pobór prądu ze wszystkich pinów mikrokontrolera maksymalnie 
130 mA. Zobacz dokumentację mikrokontrolera. 

 

 

4.1.6 Czytnik kart microSD 
 

Czytnik kart microSD został podłączony do mikrokontrolera poprzez interfejs SPI, zgodnie z 

poniższą tabelą. 

Pin karty SD (funkcja w trybie SPI karty SD) Pin mikrokontrolera 

DAT0 (MISO) MISO 

CMD (MOSI) MOSI 

CLK (Clock / SCK) SCK 

DAT3 (Chip Select / CS) D11 
 

🛈 

Więcej informacji o podłączaniu karty SD do Arduino można znaleźć 
w dokumentacji biblioteki oraz poradniku. 

 

4.1.7 Moduł radiowy 
 

Moduł radiowy SX1278 został podłączony do mikrokontrolera poprzez interfejs SPI oraz 

dodatkowe piny GPIO, zgodnie z poniższą tabelą: 

 

Pin modułu SX1278 Pin mikrokontrolera 

MISO MISO 

MOSI MOSI 

SCK SCK 

NSS D10 

RESET nRESET 

https://www.microchip.com/wwwproducts/en/ATSAMD21G18
https://www.microchip.com/wwwproducts/en/ATSAMD21G18
https://www.arduino.cc/en/Reference/SD
https://www.arduino.cc/en/Reference/SDCardNotes
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DIO0 D12 

DIO1 D91 
 

 

Przypisy: 

1 – domyślnie pin DIO1 nie jest podłączony do pinu mikrokontrolera D9, aby to zrobić należy 

wlutować rezystor R10 - wielkość SMD0603 o wartości 0 - 100  lub zworkę np. kawałek drutu. 

Nie jest to jednak niezbędne do wykonania misji CanSata, instrukcja przez cały czas zakłada, że 

pin jest odłączony.  

🛈 

Szczegółowe informacje o module radiowym SX1278 można znaleźć w jego 
dokumentacji. 

 

4.1.8 Parametry mechaniczne 
 

Kształt płytki: koło o promieniu 30 mm ze ściętymi fragmentami – w miejscu ścięcia szerokość 

54.4 mm. 

Na płytce rozmieszczone są 4 otwory montażowe przeznaczone na śruby M3 (średnica 3.2 mm). 

Otwory posiadają metalizowane obręcze (średnica 6.5 mm), podłączone bezpośrednio do masy 

(GND). 

https://cdn-shop.adafruit.com/product-files/3179/sx1276_77_78_79.pdf
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Masy poszczególnych elementów zestawu zebrane są w tabeli: 

Element Masa 

Płytka główna 18 g 

Płytka prototypowa + złącza goldpin 10 g 

Czujnik ciśnienia 1 g 
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4.2 Czujnik temperatury 

🛈 

Szczegółowe informacje o czujniku temperatury LM35 można znaleźć w jego 
dokumentacji. 

  

4.2.1 Parametry pomiarowe 
 

• 0.5 °C dokładności (w temperaturze 25 °C) 

• Dostosowany do zakresu temperatur −55 °C to 150 °C 

• Niskie samoogrzewanie (self-heating), 0.08 °C w stojącym powietrzu 

• Nielinowość pomiaru ±¼ °C (typowo) 

 

4.2.2 Zasilanie 
 

• zakres napięcia zasilania: 4 V – 20 V  

• pobór prądu: 60 μA 

 

4.2.3 Interfejs 
 

LM35 jest czujnikiem analogowym. Informacja o mierzonej temperaturze zakodowana jest 

w postaci napięcia wyjściowego obecnego na pinie nr 2 czujnika, zgodnie z równaniem: 

𝑉𝑜𝑢𝑡 = 𝑇 [℃] ⋅ 10 [𝑚𝑉/℃] 

gdzie 𝑇 [℃] jest mierzoną temperaturą. 

 

4.2.4 Pinout 
 

Poniższy obrazek pokazuje identyfikację pinów czujnika LM35: 

http://www.ti.com/lit/ds/symlink/lm35.pdf
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1. VCC 

2. OUT 

3. GND 

 

4.2.5 Parametry mechaniczne 
 

Czujnik posiada obudowę plastikową typu TO-92 z trzema wyprowadzeniami. Przybliżone 

wymiary czujnika przedstawione są w dokumentacji obudowy TO-92 (strony 29-30). 

 

4.3 Czujnik ciśnienia atmosferycznego 

🛈 

Szczegółowe informacje o czujniku ciśnienia atmosferycznego BMP280 można 
znaleźć w jego dokumentacji. 

 

4.3.1 Parametry pomiarowe 
 

• Zakres pomiaru ciśnienia: 300 - 1100 hPa 

• Zakres pomiaru temperatury: od –40 - 85 °C 

• Dokładność bezwzględna (0 - 65 °C): ±1 hPa 

• Dokładność względna (700 – 900 hPa przy +25 °C do +40 °C): ± 0.12 hPa (odpowiada 

±1 m) 

• Czas pomiaru: od 5.5 ms 

 

http://www.ti.com/lit/ds/symlink/lm35.pdf
https://www.bosch-sensortec.com/products/environmental-sensors/pressure-sensors/pressure-sensors-bmp280-1.html
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4.3.2 Zasilanie 
 

• zakres napięcia zasilania: 1.71 V – 3.6 V  

• pobór prądu: < 1 mA 

 

4.3.3 Interfejs 
 

• komunikacja z mikrokontrolerem poprzez cyfrowy interfejs I2C (linie SDA i SCL) 

• adres I2C czujnika: 0x76 

• zarówno mikrokontroler, jak i czujnik na swojej płytce posiadają odpowiednie rezystory 

podciągające linie SDA i SCL (pull-up), wymagane do prawidłowej pracy interfejsu I2C 

• alternatywnie możliwość użycia interfejsu SPI – szczegóły dostępne w dokumentacji 

czujnika 

 

4.3.4 Pinout 
 

Pogrubione skróty obecne są na spodniej stronie płytki czujnika: 

• VCC - Napięcie zasilania 3.3 V 

• GND - Masa 

• SCL - Zegar I2C / SPI 

• SDA - Linia danych I2C / MOSI w trybie SPI 

• CSB - Chip Select (standardowo nieużywany, nieprzylutowany) 

• SD0 - MISO w trybie SPI (standardowo nieużywany, nieprzylutowany) 

 

4.3.5 Parametry mechaniczne 
 

• Czujnik jest przylutowany do niewielkiej płytki PCB ze złączem w postaci listwy kołkowej 

6-pin o rastrze 2.54 mm. 

• Dostępne są również dwa otwory montażowe o średnicy 3 mm. 

• Rozmiar płytki: 15 x 10 mm 

• Masa: 0.6 g 
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5 Uruchomienie zestawu 
 

5.1 Instalacja i konfiguracja środowiska Arduino IDE 
 

1) Pobierz program Arduino IDE w wersji desktop przynajmniej 1.8.5 ze strony 

https://www.arduino.cc/en/main/software dla swojego systemu operacyjnego. 

2) Zainstaluj oprogramowanie zgodnie z instrukcjami dla swojego systemu operacyjnego: 

https://www.arduino.cc/en/Guide/HomePage . 

3) Uruchom Arduino IDE i przejdź do opcji: „Tools → Board: … → Boards Manager…”. 

 

 

4) W oknie „Boards Manager” wyszukaj “SAMD” i zainstaluj paczkę „Arduino SAMD Boards (32-

bits ARM Cortex-M0+)” w najnowszej wersji i zamknij okno.  

 

 

https://www.arduino.cc/en/main/software
https://www.arduino.cc/en/Guide/HomePage
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5) Po zainstalowaniu pakietu płytek Arduino SAMD należy wybrać rodzaj płytki, która będzie 

używana – w menu „Tools → Board → Arduino M0”. 
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6) Przejdź do zakładki „Sketch → Include Library → Manage Libraries…” i wyszukaj bibliotekę 

„CanSat Kit Library”, a następnie kliknij „Install”. 
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Po chwili biblioteka powinna być oznaczona jako zainstalowana: 

 

Porada: warto sprawdzać co jakiś czas czy dostępne są aktualizacje bibliotek (z poziomu 

menedżera bibliotek). 

 

7) W menu „File → Examples → CanSat Kit Library” dostępne są przykładowe programy. 
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5.2 Podłączanie płytki do komputera za pomocą portu USB 
 

1) Używając kabla mini USB dołączonego do zestawu podłącz jedną z płytek głównych CanSat 

Kit do komputera PC. 

2) W menu „Tools → Port” powinna być widoczna płytka Arduino M0 pod nazwą „COMx 

(Arduino M0)”. Po wybraniu tego portu możliwe będzie programowanie i komunikacja 

z podłączoną płytką. 
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5.3 Wgranie pierwszego programu „Hello CanSat” 
 

1) Otwórz przykładowy program „File → Examples → CanSatKit → HelloCanSatKit” 

2) Upewnij się, że płytka jest podłączona do komputera, a Arduino IDE ustawione jest zgodnie 

z punktami 5.1 5) oraz 5.2. 

3) Po wciśnięciu przycisku „Upload” (na pierwszym rysunku poniżej) rozpocznie się kompilacja 

i wgrywanie oprogramowania na płytkę (drugi rysunek): 
 

 
 

 
 

Proces wgrywania jest sygnalizowany przez miganie niebieskiej diody D13. 
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4) Po zakończeniu wgrywania (jak na rysunku poniżej) nowy program jest wykonywany przez 

płytkę CanSat Kit. 

 

 
 

5) Ostatnim krokiem jest weryfikacja działania programu. 

̶ Dioda LED D13 powinna migać co 1 sekundę. 

̶ Po otwarciu Monitora Portu Szeregowego (Serial Monitor): „Tools → Serial Monitor” lub 

ikona lupy w prawym, górnym rogu Arduino IDE na ekranie powinny wyświetlać się 

komunikaty przesyłane do komputera przez płytkę CanSat Kit.  

Uwaga! Należy upewnić się, że wybrana jest prędkość „115200 baud” – jak pokazano na 

obrazku poniżej: 

 

 

 

Uwaga! Po wgraniu oprogramowania może zmienić się numer portu COM – aby otworzyć 

„Serial Monitor” może okazać się konieczne ponowne wybranie portu - patrz 5.2 pkt. 2). 

Wynik działania programu jest widoczny na obrazku poniżej: 
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5.4 Podłączenie i testy czujnika temperatury 
 

1) Podłącz czujnik temperatury do płytki CanSat Kit w następujący sposób: 

 

Piny płytki CanSat Kit Piny czujnika LM35 

+5 V (1) Vcc 

A0 (2) OUT 

GND (3) GND 

 

2) Otwórz przykładowy program „File → Examples → CanSatKit → TemperatureSensor” i wgraj 

go na płytkę. 

3) Po otwarciu Monitora Portu Szeregowego (Serial Monitor) na ekranie wyświetlone zostaną 

pomiary temperatury. Alternatywnie można otworzyć aplikację „Kreślarka”: „Tools → Serial 

Plotter” (lub kombinacja klawiszy Ctrl-Shift-L). 
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5.5 Podłączenie i testy czujnika ciśnienia 
 

1) Podłącz czujnik ciśnienia do płytki CanSat Kit w następujący sposób: 

 

Piny płytki CanSat Kit Piny czujnika ciśnienia BMP280 

+3.3 V VCC 

GND GND 

SCL SCL 

SDA SDA 

 

2) Otwórz przykładowy program „File → Examples → CanSatKit → PressureSensor” i wgraj go 

na płytkę. 

3) Po otwarciu Monitora Portu Szeregowego (Serial Monitor) na ekranie wyświetlone zostaną 

pomiary ciśnienia. Alternatywnie można otworzyć aplikację „Kreślarka”: „Tools → Serial 

Plotter” (lub kombinacja klawiszy Ctrl-Shift-L). 
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5.6 Używanie karty micro SD 
 

Do uruchomienia tego przykładu konieczne będzie włożenie karty pamięci micro SD do 

odpowiedniego slotu na płytce. Polecane jest używanie kart o niewielkich rozmiarach 

np. 128 MB – 8 GB. 

1) Włóż kartę micro SD do slotu na płytce (stykami karty SD do płytki), podłącz płytkę kablem 

USB do komputera. 

2) W środowisku Arduino IDE otwórz przykład Datalogger: „File → Examples → SD → 

Datalogger”. 
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3) Dokonaj niezbędnych modyfikacji w programie: 

̶ stałą const int chipSelect = 4; zamień na const int chipSelect = 11; 

̶ wszystkie wystąpienia wyrazu Serial zamień na SerialUSB. 

4) Skompiluj i wgraj program na płytkę. 

5) Otwórz monitor portu szeregowego i obserwuj dane które powinny być zapisane na kartę SD 

(program wyświetla i zapisuje wartości z trzech wejść analogowych do których można 

podłączyć np. czujnik LM35). W przypadku błędów inicjalizacji karty SD lub błędów zapisu 

stosowne informacje będą również wyświetlone. 

6) Po pewnym czasie (kilku minutach) odłącz płytkę od zasilania, wysuń kartę ze slotu i włóż do 

czytnika w swoim komputerze PC. Odczytaj zawartość pliku z danymi i sprawdź, czy są one 

poprawne. 
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5.7 Używanie modułu radiowego 
 

Do tego przykładu potrzebne będą dwie płytki CanSat Kit – jedna będzie pełniła rolę nadajnika 

(CanSat), a druga odbiornika (stacja naziemna). 

 

5.7.1 Konfiguracja nadajnika 
 

1) Otwórz przykładowy program „File → Examples → CanSatKit → 

RadioTransmitHelloCanSat” i wgraj go na płytkę. 

2) Otwórz monitor portu szeregowego, zaobserwuj pojawiające się komunikaty – porównaj 

z poniższymi:  

 

 
 

3) Zaobserwuj miganie diody D13 – sygnalizuje to poprawną pracę nadajnika. 
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5.7.2 Konfiguracja odbiornika 
 

Następnie należy uruchomić odbiornik radiowy na drugiej płytce. 

1) Podłącz drugą płytkę do komputera. 

2) Wybierz port COM odpowiadający drugiej płytce. 

3) Otwórz przykładowy program „File → Examples → CanSatKit → RadioReceiver” i wgraj go 

na płytkę. 

4) Otwórz monitor portu szeregowego, zaobserwuj pojawiające się komunikaty – oznaczają 

one odebrane pakiety: 

 

 

 

5) Parametr RSSI (Receiver Signal Strength Indicator) wskazuje siłę sygnału w odbiorniku. 

Zaobserwuj jak zbliżanie i oddalanie płytek wpływa na wartość RSSI. 
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5.8 Podłączenie anten 
 

🛈 

Krótkodystansowa komunikacja np. podczas testów oprogramowania może odbywać 
się bez anten. 

 

Polecaną anteną do płytki umieszczonej w minisatelicie CanSat jest ćwierćfalowa antena 

monopolowa wykonana z giętkiego przewodu typu linka/drut o długości około 14 cm. Taka 

antena może być przylutowana bezpośrednio do środkowego pola lutowniczego oznaczonego 

CN1/ANT: 

 

Przewód należy zabezpieczyć przez ułamaniem w miejscu lutowania – należy zrobić tzw. „stress 

relief” za pomocą np. kleju epoksydowego lub na gorąco. 

Do płytki stacji naziemnej przewidziane jest złącze SMA, które należy wlutować w miejsce 

CN1/ANT w następujący sposób:  

Miejsce na przylutowanie 

przewodu / anteny 

https://i.stack.imgur.com/vnF6U.jpg
https://i.stack.imgur.com/vnF6U.jpg
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Do takiego złącza można przyłączyć większą antenę np. typu Yagi-Uda za pomocą kabla 

koncentrycznego 50 Ω. 

 

6 Zestaw analogiczny 

 

Zestaw CanSat Kit można odtworzyć przy użyciu ogólnodostępnych komponentów i modułów 

elektronicznych. Prototypowanie, eksperymenty i testy, które mogą spowodować przypadkowe 

uszkodzenie zestawu CanSat Kit poleca się przeprowadzać na zestawie analogicznym. 

6.1 Lista elementów zestawu analogicznego 
 

• Arduino M0 (lub odpowiednik np. Wemos SAMD21 M0) x 2 

• Moduł radiowy SX1278 x 2 

• Moduł czytnika kart SD x 2 

• Moduł czujnika ciśnienia BMP280 x 1 

• Czujnik LM35 x 1 

• Płytka stykowa x 2 

• Kable połączeniowe do płytki stykowej i modułów 
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6.2 Podłączenie modułów 
 

Moduł radiowy należy podłączyć do Arduino M0 zgodnie z rozdziałem 4.1.7 Moduł radiowy, 

natomiast czytnik kart micro SD zgodnie z rozdziałem 4.1.6 Czytnik kart microSD. W obu 

przypadkach należy pamiętać o podłączeniu zasilania zgodnie z wymaganiami zakupionych 

modułów. Czujniki LM35 i BMP280 należy podłączyć w identyczny sposób jak do płytki głównej 

CanSat Kit. 

 

6.3 Różnice i ograniczenia 
 

     

Zestaw analogiczny dostarcza takie same poziomy napięć jak zestaw CanSat Kit 
(3.3 V, 5 V), jednakże wydajność prądowa poszczególnych linii zasilania może być 
inna, w zależności od zakupionej wersji Arduino M0 lub jego odpowiednika. 

 

     

Zestaw analogiczny nie może być zasilany z baterii/akumulatorów o takim samym 
napięciu jak zestaw CanSat Kit. 

 

     

Po pomyślnych testach na zestawie analogicznym należy przeprowadzić testy na 
zestawie CanSat Kit! 

 

     

Testy zasięgu radiowego powinny być prowadzone na zestawie CanSat Kit ze 
względu na duży wpływ toru radiowego i anten na osiągi. 
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7 Bezpieczeństwo i zasady prawidłowego użytkowania 
 

1) Zestaw przeznaczony jest do celów edukacyjnych, badawczych i rozwojowych. 

2) Użycie zestawu na zewnątrz wymaga zastosowania obudów chroniących przed wilgocią, 

bezpośrednim kontaktem z wodą, zanieczyszczeniami i pyłem. 

3) Zestaw powinien być zasilany zgodnie z instrukcjami zawartymi w niniejszym dokumencie. 

Nieprawidłowe podłączenie zestawu może doprowadzić do jego uszkodzenia i komponentów 

podłączonych do zestawu, silnego nagrzania elementów, wzniecenia otwartego ognia, a nawet 

eksplozji akumulatorów (jeśli były podłączone). 

4) Zewnętrzne urządzenia elektroniczne powinny być podłączone do zestawu przez dedykowane 

do tego złącza wymienione w rozdziale 4.1.2 Mapa złącz, gniazd i diod LED. Podłączanie, 

lutowanie czy wprowadzanie innych modyfikacji do zestawu skutkuje utratą gwarancji i może 

doprowadzić do uszkodzenia zestawu. Należy przestrzegać ograniczeń odnośnie użytkowania 

wyprowadzeń zestawu i podłączania urządzeń zewnętrznych, które są wymienione w niniejszej 

instrukcji. 

5) Zestaw jest czuły na wyładowania elektrostatyczne ESD, które mogą doprowadzić do 

uszkodzenia części lub całości urządzenia. Zaleca się stosować procedury zmniejszające ryzyko 

powstawania wyładowań elektrostatycznych (maty, opaski uziemiające itp.). 

6) Zestaw nie powinien być użytkowany w przypadku stwierdzenia widocznego uszkodzenia 

jakiejkolwiek jego części do czasu zweryfikowania wpływu zaistniałego uszkodzenia lub 

naprawienia usterki. 

7) W przypadku stwierdzenia nadmiernego nagrzewania się elementów zestawu, podejrzanego 

zapachu, pojawienia się dymu lub ognia należy natychmiast odłączyć cały zestaw od wszelkich 

źródeł zasilania. 

8) Elementy zestawu należy czyścić za pomocą suchej lub nasączonej alkoholem izopropylowym 

antystatycznej ściereczki. Wyjątek stanowi czujnik ciśnienia BMP280, który może być 

czyszczony tylko ściereczką suchą. 

9) Zużyte elementy zestawu powinny zostać zutylizowane zgodnie z obowiązującym prawem, 

w szczególności nie mogą być wyrzucane wraz z odpadami ogólnymi. 



załącznik nr 2 do zapytania ofertowego 

 
KLAUZULA INFORMACYJNA Z ART. 13 ROZPORZĄDZENIA PARLAMENTU EUROPEJSKIEGO  
I RADY (RODO) 
Zgodnie z art. 13 ust. 1 i 2 rozporządzenia Parlamentu Europejskiego i Rady (UE) 2016/679 z dnia 27 
kwietnia 2016 roku w sprawie ochrony osób fizycznych w związku z przetwarzaniem danych osobowych 
i w sprawie swobodnego przepływu takich danych oraz uchylenia dyrektywy 95/46/WE (ogólne 
rozporządzenie o ochronie danych) (Dz. Urz. UE L 119 z 4.05.2016, str. 1), dalej „RODO”, informuję, 
że: 
Administratorem Pani/Pana danych osobowych jest Centrum Nauki Kopernik, Warszawa (00-390), ul. 
Wybrzeże Kościuszkowskie 20, wpisane do Rejestru Instytucji Kultury prowadzonego przez Prezydenta 
m.st. Warszawy pod numerem 02/06. Z Administratorem danych można skontaktować się pisząc na 
powyższy adres siedziby lub wysyłając wiadomość na adres e-mail: informacja@kopernik.org.pl 

 
1. Administrator wyznaczył inspektora ochrony danych (IOD) Z IOD można kontaktować się we 

wszystkich sprawach związanych z przetwarzaniem danych. Kontakt do IOD: iod@kopernik.org.pl 
2. Pani/Pana dane osobowe przetwarzane będą na podstawie art. 6 ust. 1 lit. c RODO w celu 

związanym z postępowaniem o udzielenie zamówienia publicznego objętego niniejszym 
postępowaniem oraz na podstawie art. 6 ust. 1 lit. b w celu zawarcia umowy. 

3. odbiorcami Pani/Pana danych osobowych będą osoby lub podmioty, którym udostępniona zostanie 
dokumentacja postępowania w oparciu o ustawę o dostępie do informacji publicznej. 

4. Pani/Pana dane osobowe będą przechowywane, przez okres 4 lat od dnia zakończenia 
postępowania o udzielenie zamówienia, a jeżeli czas trwania umowy przekracza 4 lat, okres 
przechowywania obejmuje cały czas trwania umowy, 

5. obowiązek podania przez Panią/Pana danych osobowych bezpośrednio Pani/Pana dotyczących, 
związane jest z udziałem w postępowaniu o udzielenie zamówienia publicznego, 
w odniesieniu do Pani/Pana danych osobowych decyzje nie będą podejmowane w sposób 
zautomatyzowany,  
(w tym w formie profilowania), mogący wywoływać wobec Pani/Pana skutki prawne lub w podobny 
sposób istotnie wpływać na Pani/Pana sytuację. 

6. posiada Pani/Pan: 
- na podstawie art. 15 RODO prawo dostępu do danych osobowych Pani/Pana dotyczących, 
- na podstawie art. 16 RODO prawo do sprostowania Pani/Pana danych osobowych1, 
- na podstawie art. 18 RODO prawo żądania od administratora ograniczenia przetwarzania 

danych osobowych z zastrzeżeniem przypadków, o których mowa w art. 18 ust. 2 RODO2, 
- Powyżej wymienione prawa można spełnić pisząc na adres siedziby Administratora lub 

kontaktując się na adres e-mail: informacja@kopernik.org.pl  
- prawo do wniesienia skargi do Prezesa Urzędu Ochrony Danych Osobowych, gdy uzna 

Pani/Pan,  
że przetwarzanie danych osobowych Pani/Pana dotyczących narusza przepisy RODO, 

9. nie przysługuje Pani/Panu: 
- w związku z art. 17 ust. 3 lit. b, d lub e RODO prawo do usunięcia danych osobowych, 
- prawo do przenoszenia danych osobowych, o którym mowa w art. 20 RODO, 
- na podstawie art. 21 RODO prawo sprzeciwu, wobec przetwarzania danych osobowych, gdyż 

podstawą prawną przetwarzania Pani/Pana danych osobowych jest art. 6 ust. 1 lit. c RODO. 
 

 

 
1 skorzystanie z prawa do sprostowania nie może skutkować zmianą wyniku postępowania o udzielenie zamówienia publicznego 
ani zmianą postanowień umowy w zakresie niezgodnym z ustawą Prawo zamówień publicznych oraz nie może naruszać 
integralności protokołu oraz jego załączników. 
2 prawo do ograniczenia przetwarzania nie ma zastosowania w odniesieniu do przechowywania, w celu zapewnienia korzystania 
ze środków ochrony prawnej, lub z uwagi na ważne względu interesu publicznego Unii Europejskiej lub państwa członkowskiego. 

mailto:iod@kopernik.org.pl
mailto:informacja@kopernik.org.pl
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